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Welcome to the first issue of TUX. Twelve years ago,
I was the Editor putting together the first issue of
Linux Journal. At that time, the biggest criticism of
the idea for starting a Linux magazine was that all
the information was available on the Internet. That
was true, but the reason for a magazine was that
someone needed to organize that information and
present it in a convenient format.

As the amount of information grew, it actually
became harder for someone to find what they wanted.
Back then, however, most people using Linux were
quite technical. As Linux evolved, it became a very suit-
able platform for a user—that is, someone who is not a
computer professional but who uses a computer. That
use could be in the office, in school, or at home.

If we compare Linux to a car, many more people
drive cars than build them or even repair them. Linux
is the same. Linux Journal is for the people who
build and repair. TUX is for the drivers. That is, if you
simply want to drive Linux and not have to lift the
hood, TUX is for you.

If, however, you are not a new Linux user, don’t
run away. New Linux applications continue to appear
at an amazing rate. Although you may have used
Linux for years, there are likely to be a lot of pro-
grams that are new to you. Us old-timers know
there usually are many ways to do the same thing.
No matter how much experience you have, TUX is

going to show you some new ways.
Although much of the information you will find

here is available on the Internet, just like the infor-
mation for the builders and mechanics of Linux was
available there 12 years ago, there is still a need for
organization and presentation. Fortunately, the tools
we have available to use the Internet have changed.

A typical Internet connection offered speeds of
about 2,000 characters per second. Today, connections
at 10–1,000 times that speed are not uncommon.

With TUX, we have decided to take advantage of
that change. Besides getting the information to you
much more quickly, there are many other advantages
of delivering TUX to you electronically. Here are a few:

n You will be able to get copies of back issues
immediately.

n In addition to what traditionally would appear in a
print publication, we can make other material avail-
able in different formats including audio and video.

n Also, cutting down trees, making them into paper,
putting ink on them and mailing them costs money.
We have decided to pass the savings of a digital TUX
on to you. Although this may be going a little over-
board, we have decided to make TUX free. That is,
no catches, no hidden costs. The only losers are the
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printing company and the post office.

Why have we selected do distribute
TUX as an electronic magazine rather
than only as Web pages? First,
http://www.tuxmagazine.com is the
magazine Web site. It has articles, com-
ments, polls, and other information.
But, current Web technology (and the
quirks of various Web browsers) don’t
offer the type of quality we want with
TUX. In addition, many of you will want
to save your copy for off-line viewing.

WHAT IS IN ISSUE 1?
Enough about what we are doing. Here is
what you have right now. We decided
that the theme of this issue would be
Getting Organized. As technology has
crept into our lives, everything that was
supposed to get easier, got harder.
Remember the idea of the paperless
office? Or of not having to get yet anoth-
er electronic or mechanical gadget fixed?

Well, most of you already are using
computers, but is that computer a real
organizational tool? It has likely helped in
some areas but not in others. So, why not
get off on the right foot with your Linux
system and get organized?

Right off the bat, two things your Linux
system can help you organize are your
music and digital photo collections. I men-
tion these first because everyone—not only
the Linux user—can appreciate what can be

done here. James Gray explains how to use
KAudioCreater as an organizational tool as
well as how to pick the right output format
to meet your size and quality restrictions.
Once you have that audio on-line, Dee-Ann
LeBlanc details how to use amaroK to listen
to it and a lot more. Finally, Aaron Seigo
shows you how to manage your photo
collection with digiKam.

Schedules are another area where
Linux can help. Lauri Watts shows you
how to organize multiple schedules and,
if you want, export your calendar as a
Web page. This leads into syncing your
Palm Pilot, and KOrganizer and KPilot are
Jenn Vesperman’s tools of choice.

RSS feeds offer a way to stay up to date
on the content of many Web sites. Kevin
Brandes shows you how to get KNewsTicker
configured to manage this job for you.

Many of you likely spend a lot of your
time in a Web browser. Articles by Nigel
McFarlane and Marco Fioretti help you
turn this into a more enjoyable and pro-
ductive experience.

The KDE environment is here to be
your slave, but you need to learn how to
ask for what you need. Phil Nelson
explains how to get KDE to tell you about
your computer, Lew Pitcher shows you
how to unclutter your desktop, and
Æleen Frisch offers tips on customizing
KDE to act the way you want.

Sometimes people see an application
running on a Linux system and say, “I can’t

belive that comes with Linux.” Although
there is more than one such application,
The GIMP, which stands for GNU Image
Manipulation Program, has had people say-
ing that for a long time. Michael J. Hammel
introduces you to The GIMP and to his
series on what you can do with The GIMP.

Finally, we round out this first issue
with an editorial by longtime Linux user
and famous columnist Nicholas Petreley
and some quick looks at products. We’re
pretty proud of what we have here, and
we hope you find it useful.

WHAT’S NEXT?
We have a basic editorial calendar, but for
the most part, that is up to you. TUX is
about how to do things. We have collected
a lot of ideas from computer users we
know, but we need more. If there is some-
thing you would like to see covered in TUX,
I encourage you either to send e-mail to
editor@tuxmagazine.com or use the Web
form at http://www.tuxmagazine.com/
xstatic/editorial/asktux and describe what
you are looking for.

What’s important to us is that we
want to show you how to do things with
Linux. There is a lot written about why
Linux is great and some about why it isn’t
great. That’s not the job of TUX. Our job
is to help you so that you will tell us, and
the rest of the world, that Linux is great.n

Phil Hughes is Group Publisher for SSC Publishing, Ltd.
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Remember the thrilling early days of the
personal computer and DOS programs?
The excitement was driven primarily 
by rapidly advancing technology and,
more importantly, competition in the
software market.

Do some of you remember all the
choices we had? I leaned toward Lotus
1-2-3 and Quattro Pro from Borland for
spreadsheets, R:Base and Ansa Paradox
for database work, Borland’s Turbo
Pascal, Watcom C, Borland C, and
Clarion for programming. WordPerfect
5.1 was my first choice for writing 
with Samna Word a close second. I
hated MicroPro’s Wordstar, Microsoft
Word, and Multimate, but to each his
own. Don’t forget the dumbed-down
PFS-Write, PFS-File, PFS-Deodorant, 
and all the other PFS applications for
people who were smart enough to 
realize they never needed any more
than the half-dozen features these 
programs offered.

But, when it came to Variety with a
capital V, there were more database
programs to choose from than John

Sebastian’s ants on a Tennessee ant hill
(re: “Nashville Cats” by the Lovin’
Spoonful). Off the top of my head, I
can recall Dataease, Paradox, R:Base,
Revelation, Progress, Dataflex, Clipper,
Clarion, Q&A, and Magic. There 
were more.

The market was exciting because
companies competed not only on the
basis of quality, but on how well they
could serve a specific target market.
Dataease had almost nothing in com-
mon with R:Base, and neither had
much in common with Revelation, yet
these were all popular database pro-
grams because they served the needs
of different types of customers. Most
of all, it was an exciting time because
we had something called choice.

The excitement hadn’t quite died
when I got a new Everex 486DX2/66
computer equipped with a whopping
32MB of RAM and two SCSI drives.
OS/2 ran like a champ on this machine,
and even Windows 3.1 ran fast enough
to use it, if I had the desire. But even
Don Corleone couldn’t figure out how

to make me an offer I couldn’t refuse
when it came to running Windows 3.1.
(Although, I admit it was traumatic to
wake up next to the chopped off head
of my favorite hobby horse.)

It was about this time that Microsoft
had spent the past few years whipping
the media into an orgasmic frenzy about
the coming of Windows 95. Microsoft
used Windows’ anticompetitive pricing
to force IBM to give up on OS/2. It was a

Choice and Excitement 
Make a Comeback!
Well-published columnist Nicholas Petreley offers us a long-term
view on personal computing and Linux.

NICHOLAS PETRELEY

MEMORY LANE

Take a walk down memory lane 
and revisit the computers of old 
at OLD-COMPUTERS.COM
(http://www.old-computers.com/
museum/default.asp). This nostalgic
site makes it fun. Search for 
an old system or browse by 
computer or company name. Hey,
there’s my old Commodore 64!
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scary time. Windows 9x was closing
in on me. I wanted to like Windows
NT, but it was merely a bloated
Windows 3.1 that didn’t crash as
much (not at first, anyway).

In a desperate fit of insanity, I
installed Linux on my 486DX2/66
machine and started using it as my
default desktop. (I had been using
Linux on my servers for a year or more,
but this was the first time I considered
it for desktop use.)

The flaws were obvious. The fonts
were hideous. The file managers were
pitiful in terms of ease of use. I loved
virtual desktops, but window man-
agers were lame in other respects. I
saw limitless possibilities for customiz-
ing FVWM, but only if I spent too
much time learning the intricacies of
configuration files.

I learned enough to make FVWM
tolerable. A bazillion applications
were available, and a few were
good enough to do my work.
Netscape worked. And to my
amazement, I never encountered an
error that forced me to reboot—
never, ever. That alone kept me
going. And as I kept going, things
kept getting better and better.

Fast-forward ten years. Where’s
the excitement and choice in the
desktop market today? I’ll tell you.
Aside from a few competing

antivirus and firewall products,
today’s choice on the Windows
desktop boils down to, “Should I
upgrade to the latest version of
Windows and Microsoft Office, or
keep using the versions I have?”

Now, let’s look at the contrast for
the Linux desktop. There are dozens of
Linux distributions. I have five installed:
Gentoo, Debian, SuSE, Fedora Core 3,
and Mandrake.

Right now, I’m using the brilliantly
designed, unfathomably feature-rich
and highly customized KDE 3.3.1 as
my graphical desktop. The fonts are
fabulous, as are the drop shadows,
fade effects, and transparency
options for menus, windows, and
other objects. My desktop is
enhanced to show me the status of
my hardware, weather reports and
forecasts, and more. I recently used
the KDE file manager to convert an
entire audio CD to MP3 files, simply
by dragging the CD track icons to an
MP3 folder. I even can add my own
features to the KDE file manager,
such as “convert these Word docu-
ments to HTML,” and KDE is smart
enough to present this option only
when I select Word documents.

And, that’s only KDE. GNOME is
powerful and easy to use, and count-
less alternative window managers are
designed to appeal to dramatically dif-

ferent tastes and needs.
I wrote this column using the

KDE-enhanced version of the full-
featured office suite, OpenOffice.org.
The competitive KDE KOffice suite
has a word processor that is terrific
for creating frame-oriented docu-
ments. When I must, I even can 
run Microsoft Word on Linux with
CrossOver Office. Ironically, I’ve 
been using MS Word to coauthor 
an upcoming O’Reilly book on Linux
Desktop Hacks, because the publisher
hasn’t finished converting its tem-
plate system to OpenOffice.org.

I use the Firefox browser, but
there’s Mozilla, Galeon, Epiphany,
Opera, and Konqueror, among 
others. Powerful e-mail clients
include KMail, Evolution (an Outlook
clone that is superior to Outlook),
Sylpheed, Thunderbird, and more.
Yes, I know some of the above 
applications run on Windows. Don’t
worry. Microsoft is hard at work
breaking them with the upcoming
Longhorn.

There are many other reasons for
the following conclusion, and per-
haps we’ll get to them sometime.
But here’s the bottom line. Friends,
choice on the desktop, and the
excitement that goes with it, is back.
And it’s all about Linux.n

P2P
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Nicholas Petreley is
an author, consult-
ant, programmer,
award-winning
columnist, and Linux
analyst for Evans
Data Corp.
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KAudioCreator is the standard, KDE-based tool for
ripping and encoding digital audio tracks from
your compact discs. “Hmm, ripping and encoding
are Greek to me”, you say? Let’s put it another
way then. KAudioCreator is a program that
reduces the file size of CD-quality digital audio
tracks up to ten-fold, using powerful compression

technologies like MP3, Ogg Vorbis, and FLAC.
Furthermore, it does this without a substantial loss
of sound quality. Smaller files mean you can pack
tons more music onto your digital audio player or
computer hard disk.

KAudioCreator is one component in a package
called kmultimedia3-CD, a suite of audio-related

tools that comes with KDE. In this article,
we discuss KAudioCreator Version 1.11,
which is included as part of KDE 3.3.

By the way, before you set off
looking for documentation on
KAudioCreator, let me save you the
trouble. There isn’t much beyond a
smattering of random Web pages.
Never fear, though, because we
cover nearly everything you need to
know right here. Let’s start by
becoming familiar with the tech-
nologies involved.

BACKGROUND ON RIPPING,
ENCODING, AND FILE FORMATS
Have you ever noticed that each of
the audio CDs stacked next to your
stereo holds about an hour’s worth
of music, give or take a few min-

utes? This is because the songs are in a sound
file format called WAV, which offers high-quali-
ty digital audio but is a storage hog. WAV files
fill about 10MB of disk storage space for each
minute of stereo audio.

When you think about music in the context
of your stereo, storage space isn’t a considera-
tion. If you want more storage space, you buy
a new CD, and you’ve got it. So, the limit on
storage space is the size of your house. Today,
there are many fun new ways to experience
digital music, but they come with an important
drawback—limited storage space. On your
computer, digital audio player, or real-time
audio streaming over the Internet, WAV files

Rip Your Audio Files Down
to Size with KAudioCreator
Whether you want to save disk space or create a CD with ten
hours of music, KAudioCreator can help you out.

JAMES GRAY
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WHY MP3 AND OGG ARE NEW

You may be thinking that if MP3 and Ogg formats
are so much more compact, why were CDs
recorded in WAV format in the first place? The
answer is simple: advancing technology.

MP3 and Ogg take advantage of compression
techniques to analyze the information and com-
press it. In order to uncompress this information,
you need to go through a conversion process.
When Compacts Discs hit the market, the technol-
ogy to perform this conversion—essentially a
computer running a program—was not available
at the size or price that it could be included in a
CD player.

Today, a small, low-power and low-cost com-
puter chip can perform this task so, although CDs
remain in WAV format for compatibility, we now
have better ways of representing the data.

HOME PLATE

Figure 1. The KAudioCreator interface shown before doing an
album (CDDB) lookup on http://freedb.org.
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are too large to be practical. At more than
600MB per audio CD, how are you going 
to get your mammoth music collection onto
the cool digital audio player you’ve been 
eyeing—and still have room for Bing Crosby’s
“White Christmas”?

Several excellent solutions are at your serv-
ice, thanks to the wonders of modern technolo-
gy. What will save you are lossy and lossless
compression techniques, which convert WAV
files from your CDs into file formats that are
significantly less storage-intensive, namely MP3,
Ogg Vorbis, and FLAC. The compression tech-
nique that creates MP3 and Ogg Vorbis files is
called lossy because it eliminates data that isn’t

critical to maintaining a reduced, but still excel-
lent, level of sound quality. Meanwhile, FLAC
utilizes a lossless compression technique, which
reduces file size considerably, without a loss in
sound quality.

With so much choice and so little time,
what’s a busy music lover to do? Although MP3
is an excellent choice with much sex appeal due
to its name recognition, we at TUX support Ogg
Vorbis and FLAC, and not simply due to Ogg’s
awesome name. The myriad reasons boil down
to two advantages, freedom and quality.
Regarding freedom, both Ogg Vorbis and FLAC
are brain children of people who value open-
source, nonproprietary, patent-and-royalty-free

solutions, all of which we hold very dear. MP3,
on the other hand, is a closed, proprietary for-
mat. Regarding quality, both Ogg and FLAC
provide you with superior audio quality vs.
MP3, which frees you to base your decision on
whether space (Ogg Vorbis) or quality (FLAC) is
a higher priority.

Getting to these file formats entails a two-
step process, ripping and encoding. The ripping
part is the act of obtaining the audio track you
want from a compact disc (a WAV file) and
getting it ready for encoding. Encoding
involves applying sophisticated compression
algorithms to the WAV file to convert it to the
new file format that’s smaller in size. For exam-

ple, the algorithms will shrink a 40MB, four-
minute WAV track to about 20MB as a FLAC
and less than 3MB as an MP3 or Ogg Vorbis
track. How cool is that?

In order to work this trick, several different
tools are needed. It helps to know that
KAudioCreator is your all-in-one tool that
steers the activities of a number of sophisticated,
clandestine sub-tools that do the heavy lifting
for you, depending on what file format you
choose. For instance, if you choose to encode
to the Ogg Vorbis format, OggEnc goes to
work. On the other hand, if you want MP3s,
LAME is called to task. (Yes, it really is called
LAME, which cleverly stands for LAME Ain’t an

MP3 Encoder.) Finally, flac is the encoder for
FLAC files.

Okay, I think you’ve got enough theory under
your belt to run with this. Let’s move on and get
our hands dirty with an example.

SAMPLE PROJECT
Before doing anything else, place a compact disc
into your CD drive before launching KAudioCreator.
Otherwise, it won’t recognize the CD. I put in Lay It
Down from Cowboy Junkies, but feel free to choose
any CD you prefer. Then open KAudioCreator by
clicking on CD/DVD Tools, which is located at
K→Multimedia. That’s the way it looks on my
SuSE system. On a Mandrake system, you’ll find

KAudioCreator listed by its own name under
Multimedia→Sound.

Those of you who hate manuals will be
tempted to start the ripping process by clicking
various buttons once you start KAudioCreator.
If you hang with me, you’ll see the features
that this action-packed program has under the
hood are worth the wait.

HOME PLATE
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TIP KAudioCreator’s program name is 
kaudiocreator. You also can run it by

using your quick launcher (press Alt-F2) and
typing in the program name.

TIP

Although MP3 is an excellent choice with much sex appeal due to its name recognition, we at TUX support
Ogg Vorbis and FLAC, and not simply due to Ogg’s awesome name. The myriad reasons boil down to two
advantages, freedom and quality. Regarding freedom, both Ogg Vorbis and FLAC are brain children of people
who value open-source, nonproprietary, patent-and-royalty-free solutions, all of which we hold very dear.

                    

http://www.tuxmagazine.com


STEP 1: BEFORE YOU RIP, ORGANIZE THE ALBUM
INFORMATION
With a CD in your CD drive and the program
launched, you should see an interface similar to
Figure 1. KAudioCreator finds and displays your
CD-drive address and sees the individual tracks,
but it doesn’t yet know the artist(s) or song
titles. Luckily, though, KAudioCreator has an
integrated Compact Disc Database, or CDDB,
which makes importing CD information a snap.
To do a lookup, simply click on the CD icon
located on the far left of the toolbar and voilà,
you have yourself a fully labeled CD.

I had some problems with CDDB at first, but
then I checked out the FAQ on freedb, the default
CDDB provider on KAudioCreator. There, I learned
that my port for the CDDB server incorrectly was
set to 8080 for the HTTP protocol. Instead, it
should be changed to 80, which I was able to do
under Settings→Configure KAudioCreator→CDDB
configuration. After that modification, the CDDB
lookups have been flawless.

What happens if you have an obscure audio
CD that is not in the CDDB? Though my
obscurest indie CDs worked like a charm, you
might have a homemade or foreign disc to rip.
In this case, click on the Edit Album icon, the
second icon from the left in the toolbar, which
looks like a piece of paper and a pencil. Here
you can enter new data describing your music,
or you can go back and tweak the info down-
loaded from CDDB, such as artist, song titles,
genre, year, and so on.

STEP 2: BEFORE YOU RIP—SELECTING DEFAULT
FILE FORMATS AND LOCATIONS
If you plan to rip numerous CD tracks with the
same file format, it’s wise to select a default to

make your life easier. You always can override the
default on the fly later on. Here’s how you set the
default: click on Settings→Configure
KAudioCreator→Encoder Configuration. This
brings up the dialog box that’s illustrated in Figure 2.
As you can see, you set your default encoder to
OggEnc for Ogg Vorbis, LAME for MP3, FLAC for
FLAC formats, respectively. Let’s choose OggEnc
for our example.

That same dialog box offers powerful tools
for organizing your audio files in an automated
way. Click the Wizard button under Encoded
File Location, and you get an array of options
for determining the storage location for your
files. The wizard lets you modify each element
in the directory structure. By default, each
album is saved automatically in a subdirectory

of your home directory, based on its file for-
mat. For instance, I ripped five different albums
in Ogg Vorbis format, and each one landed in
its own subdirectory in home/JamesGray/ogg.
Similarly, the albums I ripped in MP3 format
ended up in a different directory,
home/JamesGray/mp3.

Finally, this dialog box creates an album
playlist file for you and places it in the directory
of your choice. If you do nothing beyond
checking the box labeled Create an album
playlist file, the album playlist is saved by
default in the same directory as the audio
tracks.

STEP 3: RIP AND ENCODE—STARTING A JOB
As promised, we finally get to rip some files.

Be sure that the CD Tracks tab is
selected on the main program
interface, and then follow these
steps:

1. Select the tracks you want to rip
by manually clicking in the column
labeled Rip. Otherwise, you can
press the button labeled Select All
Tracks to select them all.

2. Start the ripping (and encoding)
process by pressing the icon with a
blue gear on it. Pressing it once gives
you the default file format you
selected earlier in the preferences.
Holding it down overrides the
default and lets you choose the
encoder you want on the fly.

3. Click over to the Jobs tab to see
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Figure 2. Setting defaults and determining file locations with the
Encoder Configuration window.
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how the ripping and encoding is pro-
gressing.

After KAudioCreator rips and encodes
the entire batch of files, the entry disap-
pears from the Jobs tab. This means that
your files are ready and waiting for you to
use. You can go and find the files in their
own directory, organized by album title. In
my example, I went with KAudioCreator’s
default on file placement, which led me
to find my Ogg Vorbis files using the
Konqueror file manager as follows:
file:/home/JamesGray/ogg/Cowboy Junkies/
Lay It Down/RespectiveSongTitle.ogg You
also can see the results in Figure 3.

STEP 4: ENJOYING YOUR MUSIC
Although the topic of audio on Linux is
worthy of its own article, let’s go over
some of the ways to enjoy your MP3, Ogg
Vorbis, and FLAC tracks.

1. Play them back on your computer:
play a song by right-clicking on the file
in your Konqueror file manager and
selecting the Open With option in the
resulting menu. Applications that will
play the song for you include XMMS,
amaroK, kaffeine, and RealPlayer. To
play an entire album, launch XMMS by
clicking K→Multimedia→Audio Player
and selecting Play Directory, which

allows you to select a
directory labeled with
an album title that
contains a series of
tracks.

2. Burn a custom CD:
the application you
want to start to burn
your own custom audio
CDs is K3b. You can
summon K3b under
K→Multimedia→
CD/DVD Burning. K3b
is an intuitive applica-
tion that walks you
through a CD-burning
project. As opposed to
KAudioCreator, K3b
has a solid manual to
support you.

3. Download selected tracks onto a 
digital audio player (aka MP3 player)
You can call your playback device an
MP3 player, a digital audio player, 
or even an Ogg Vorbis player after
reading this article. The latter name 
is becoming more realistic because
numerous players are now compatible
with the Ogg Vorbis format. Whatever
you decide to call your player, you
now can pack tons more music onto
it, thanks to the size reduction afforded
by the MP3, Ogg Vorbis, and FLAC
formats.

As we conclude, I want to be sure you
are aware that KAudioCreator has many
other neat features with which to tinker
and that we’ve only scratched the surface.
Because you now have solid knowledge
of the main features, procedures, and file
formats, you should feel confident as you
try new things. I wish you much success
and enjoyment as you explore this excit-
ing area in digital audio. Rip and encode
with confidence!n
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James Gray has
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ing and promotion
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Linux, No Starch
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Figure 3. I used Konqueror to locate the ripped files in
KAudioCreator’s default directory.

RESOURCES

freedb: http://www.freedb.org

Ogg Vorbis Home Page:
http://www.vorbis.com

Free Lossless Audio Codec (FLAC):
http://flac.sourceforge.net

                     

http://flac.sourceforge.net
http://www.vorbis.com
http://www.freedb.org
mailto:jgray@ssc.com
http://www.tuxmagazine.com


I don’t know about you, but I like listening to music.
My tastes are pretty eclectic, and I enjoy taking all of
my tunes and mixing them up so I never know what
will come on next. I spend a ridiculous amount of time
burning songs off of my CD collection, so I can mix
and match to my heart’s content using my computer.

Many programs exist to handle this task.
Rather than cover them all, I focus on the
coolest one out there, a program called amaroK
(http://amarok.kde.org). amaroK (Figure 1) is a
music organizer that can play CDs, music files, and
streaming audio (Internet radio). Features include
the ability to create multiple playlists, automatically
search out and display album covers, and more.

SETTING UP AND STARTING AMAROK
Many Linux distributions (including Mandrake 10.1
and SuSE 9.2) include amaroK as part of their offer-
ings. Playing songs and organizing your collection is
standard across most versions of amaroK, but some
advanced features, such as the album cover manager,
are available only with recent versions.

You can start amaroK by typing amarok in the
run box (Alt-F2) or by locating it in the menus. On
SuSE 9.2, it is at K→Multimeida→Audio
Player→amaroK. In most distributions, the first
dialog box you encounter is the First Run Wizard.
This handy tool walks you through things like

telling amaroK where to find your music files. If it
does not appear, have no fear. You can tell
amaroK what it needs to know later.

FINDING YOUR WAY AROUND
amaroK’s Playlist window (or main window if you
elect to keep the program in one piece) has a some-
what complex interface, so it’s worth taking a tour to
learn where to find everything. Along the left of the
Playlist window (Figure 2) are a set of tabs. These
tabs are not identical for every version of amaroK,
but if you’ve updated your software recently, you
should find a setup at least similar to what is dis-
cussed here. Selecting a tab changes what you see in
the Playlist window’s left-hand side.

In the Context tab (Figure 3), you can see infor-
mation about the song that is currently playing,
including its album cover (if your version of amaroK
supports this feature), the other songs on the album,
and more. If you’re not currently playing music, the
Context tab shows the tracks you have played the
most often (under Favorite Tracks) and the ones you
added most recently (under Newest Tracks).

Below the Context tab is the Collection tab.
Here, you can browse through your entire music
collection. In the Actions menu within this tab,
choose Configure Collection Folders if you want
to add more folders of music.
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The Amazing amaroK: 
Let the Music Play
Although a boom box may be cheap, there are a lot of reasons to use your
Linux system to play audio. Dee-Ann LeBlanc takes a look at one of the
many tools available that takes Linux way beyond what a boom box can do.

DEE-ANN LEBLANC

Figure 1. amaroK in its two-part mode, where the
player and playlist/organizer are separated, with
the cover browser visible as well.

Figure 2. The Playlist window with the Playlist tab
displayed and the Cool-Streams playlist, full of
Internet radio stations, expanded.
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You also can select Cover Manager to open the
Cover Manager window (Figure 4) or right-click on
the main player and select it there. The Cover
Manager is a very cool feature that makes it possible
to (more or less) automatically download cover
graphics to display while the songs are playing. To
load these images once you have the window open,
make sure you are connected to the Internet, and
then simply click the Fetch missing covers button.
The album title information is used for a search on
Amazon’s Web site for images, which are then
downloaded and stored in amaroK’s local database.

Beneath Collection is the Playlists tab, shown
earlier in Figure 2; how to use this tab is discussed
later in this article. Under Playlists is the Search
tab, which lets you search your filesystem—maybe
you have some music files scattered who knows
where and want to add them manually or move
them into your music folder(s). Beneath Search is
Files, which lets you browse your filesystem manu-

ally, either by using the browser buttons at the
top of the panel or by typing in filesystem paths.

On the lower right of this window is a Menu
button (if you don’t see one, you can access the
menu by right-clicking in the player window as
well). Clicking this button shows you the options
for repeating particular tracks and whole playlists,
along with enabling random mode so songs don’t
always play in the same order. Configuration
entries for various aspects of amaroK also are
located here, including Visualizations, which pulls
up various graphical ways of interpreting the music
(I recommend libwmdiscotux.so for a chuckle).

If you want to configure the player’s look and
feel, open the Menu and select Configure
amaroK. You can alter things like the fonts used in
the windows, the color schemes, whether or not
to use On Screen Display (OSD), which pops up a
brief window showing you what song is starting
to play, and more.

LISTENING TO MUSIC
On the right side of the window is your playlist, once
you build one. To put a song in the playlist, drag it
from the Collection screen into the right pane. You
also can drag a whole folder over to add a whole
album, though the album is added to the playlist
song by song. To start playing music, simply click the
Play button in the player window. The player
includes a tiny PL button. Click this button to get rid
of the Playlist or to bring it back when you need it.

Once you have a playlist that you’re happy with,
click the Save Playlist button on the bottom part of
the main window. A Save As dialog box appears.
Tell amaroK where to save the file and what name
to use, and then click Save. Two types of smart
playlists also are available. The first is made auto-
matically, according to your listening habits. Both of
these options are under the Save Playlists tab.

To use the pre-existing smart playlists, look to the
bottom section of the Save Playlists tab. There you
should see entries such as All Collection, Favorite
Tracks, and so on. Browse through these until you
find the one you want, and then double-click on it
to open its contents into the right side of the win-
dow. In some cases, such as the Genres section, you
may find that most of your music doesn’t have the
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Figure 3. The Playlist window with the Context tab
displayed.

Figure 4. The Cover Manager window with the
covers amaroK was able to find on Amazon.com.

NOTE:
As with all applications where development is
fast and furious, amaroK is undergoing constant
tweaks to the interface and to its features.
While testing a bleeding-edge development ver-
sion of amaroK, I noticed that the menu had
been moved to a top menu bar in the playlist
window, in much the same location as you
would expect to find it with most applications.
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proper tags applied to it, so when you dou-
ble-click on Blues there’s only one song
there. You can fix this problem by selecting
the Collection tag, right-clicking the songs to
which you want to assign values, and select-
ing View/Edit Meta Information (Figure 5).
Actually, you can right-click and select this
option pretty much anywhere amaroK shows
you the name of the song.

If you don’t want to change all of the
meta-information, but instead want to edit
only one aspect of an item in your playlist in
the right side of your window, right-click that
component and choose Edit Tag Inline: tag,
where tag is the entry you want to change.
For example, maybe a song’s title is misspelled
and it’s annoying you. Right-click the title in
the right-hand listing, choose Edit Tag Inline:
Title, and then make your changes without
having to deal with extra dialog boxes.

To create a brand-new smart playlist
that follows your own criteria, select the
Playlists tab and click the Create Smart
Playlist button. The Create Smart Playlist
dialog box appears, in which you can
assign the playlist a name, and then set the
various rules for the songs it should con-
tain. From here, you can specify all kinds of
conditions, such as the score you assigned
the song, its genre, the artist involved, and
more, and then have the songs sorted by
rules you select. If you want multiple con-
ditions, click the + button to the right of
the first set and another becomes avail-
able, letting you get as complex as you
want. Once you’re finished creating your
playlist rules, click OK, and then look down
in the Smart Playlists section. You’ll see
your custom list at the bottom. Double-
click it, and its contents appear to the
right. To start playing what’s in your
playlist, click the Play button.

Of course, amaroK can play more than
music files. You also can use amaroK to lis-
ten to streaming audio, like Internet radio.
In some versions of amaroK, this feature is
in the Playlists tab; other versions have a
special Streams tab. If your version has no
Streams tab, look in the Playlists tab for the
Cool-Streams playlist. Expand this list to
see the list of on-line radio stations that
amaroK already knows about. You can
specify your own favorite station by click-
ing the Add Media button, typing the URL
in the Location text box, and then clicking
OK. Double-click a station to listen to it.

Those who have a Streams tab need to
click the Fetch Latest Streams button at

the top of this tab to grab the list of sta-
tions from the station server. To add your
own station to the list, click the Share but-
ton to open the Share dialog box, and
type in all of the appropriate information
about the station (choose Direct Stream
from the Type listbox). When you click OK,
your station is not added to your own list
only, but also is uploaded to the server so
other people can see the station in their
listings as well. Drag a station over into
the top of your playlist, and then double-
click it in the playlist to listen to it.

amaroK will hide nicely in your KDE
panel’s system tray. If you want to get
amaroK out of the way, click the X in the
upper-right corner of the player’s window
to close all of the amaroK windows and
minimize the tool onto your system tray
while your music keeps playing. When it’s
in the tray, you can single-click the icon to
open up the windows you minimized, or
you can right-click the icon and select Quit
to close amaroK completely.

SOUNDING OFF
If you’re like me, life is just missing some-
thing if music isn’t music playing some-
where. Tools like amaroK can make organ-
izing and enjoying your music collection a
lot easier and more fun than using a multi-
CD changer or having to sort files into par-
ticular directories so you can listen to
exactly what you want, when you want to.
Given that the promise of computers was
that they were supposed to make our lives
easier, it’s always nice to find a tool that
actually delivers.n
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Figure 5. The Tag Editor, for assigning
meta-information to your music files.

Dee-Ann LeBlanc is
the award-winning
author of 13 com-
puter books (mostly
focused on Linux) as
well as an award-
winning technical
journalist with over
two-hundred articles
behind her. Her latest
book is Linux for
Dummies, 6th
Edition, and you can
learn more about her
at http://www.Dee-
AnnLeBlanc.com.
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Consumer electronics have changed how we record
and share our life experiences. Home computers,
portable digital music players, cell phones, and
other devices have taken much of the information
that was once available only on bits of paper and
plastic and freed them to roam in the digital
expanses of our computers and the Internet.

Photography has not been passed over in this
digital revolution either. The image quality of
consumer-grade digital cameras has improved by
leaps and bounds, and prices have fallen steadily.
Today, more digital cameras are sold than traditional
film cameras. This is not surprising as digital photog-
raphy is more immediate, flexible, and convenient
than traditional photography, and it also is more cost
effective as there are no film and development costs.

But this transition to a digital medium for pho-
tography has meant changing how we work with
the images from our life. With film photography,
the prints most often were organized and
archived simply by placing them in photo albums,
and making prints was as easy as taking the cam-
era to a store that develops film. In the digital
age, the role of developer, album maker, and even
photo retoucher is being played by software that
runs on our home computers.

One of the more advanced and user-friendly

digital photography applications available today is
digiKam. digiKam makes organizing and manag-
ing collections of photographs easy, and as with
most Linux software, it is freely available.

DIGIKAM 101
At the most basic level, digiKam helps organize
photographs into albums. The first time digiKam
starts, it displays a welcome screen asking where
you would like to store these albums. The default
location is a folder called Pictures in your home
folder. You can choose a different folder or press
the OK button to continue. If the folder you select
does not exist, digiKam creates it for you.

The main digiKam window appears next, and this

where most of the action happens. This window is
split into two work areas, much like a file manager
with a list of albums and tags (more on tags later) on
the left and a photo viewing area on the right.

The first task after starting digiKam is to create
one or more albums in which to put pictures. We
do this by selecting New Album... from the File
menu or by clicking the New Album icon in the
toolbar. A window pops up asking us to name the
album as well as to provide some additional,
optional information, such as a comment and a
date. Once we have provided a title for the album
and press the OK button, the new album appears
in the My Albums list.

With an album created, we now can go about
the business of putting photographs in it. If the
photos are already on the computer, we simply

Managing the Digital 
Photo Album with digiKam
With conventional photography, a shoe box was the most common organizing tool.
In the age of digital photography, we all need a better organizing tool, and digiKam is such a tool.

AARON SEIGO

Figure 1. Albums Library Folder

Figure 2. Main digiKam Window
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can click the Add Images button on the toolbar or
select one of the Import options from the File
menu. Doing so opens the standard file dialog
from which you can locate your pictures. This is
useful when photographs arrive by e-mail or are
saved from a Web site. But what about the pic-
tures stored on our digital camera?

USING A DIGITAL CAMERA WITH DIGIKAM
digiKam makes working with most digital cameras
quite easy. First, connect the camera to the computer
and turn it on. Select the Add Camera option from
the Camera menu and click the Auto-Detect button
in the window that appears. This causes digiKam to
scan your system for known cameras.

If digiKam doesn’t find the camera automatically,
clicking the Add button brings up the camera selec-
tion window. Simply select the model of the camera
you want to use with digiKam from the list on the
left. If your camera model does not appear in the
list, and it connects to the computer with the USB

port, select the USB Mass Storage option.
If you are using the USB Mass Storage option, you

also need to provide the mount point for the camera.
The mount point is the folder that your camera
appears in as set up by your operating system. This
usually is found in either the /mnt or /media folders.
Consult the documentation that came with your
Linux OS, or browse the /mnt and /media folders with
your camera on and plugged in to the computer.

After clicking OK, the camera should appear in
the cameras list. Close the configuration dialog,
and you now are ready to begin adding photo-
graphs to digiKam directly from the camera. To
download photos from the camera, open the
Camera menu and select the camera you just set
up. A window showing the photos stored on the
camera appears. Select which pictures you want
to download, or simply click the Download button
and select Download All. After asking which
album to put the photos in, digiKam starts trans-
ferring the images to your computer. Once the
transfer is complete, you can use the Delete but-
ton to remove pictures from the camera to free up
space for future photographic adventures.

ALBUMS, PHOTOS, AND TAGS—OH MY!
With our photos in an album, we now can go
through them and decide which to keep, which to
edit, and which to delete. Selecting an album
from the My Albums list brings up thumbnails of
all the images in the album in the viewing area.

Hovering the mouse pointer over a photo-
graph’s thumbnail shows a floating window that
displays various details about the photograph,
such as when it was taken, how big it is, and
which album and tags are associated with it. This
same information (and more) can be viewed by
selecting a photograph and clicking on the

Properties button in the toolbar.
Clicking on an image brings up the image

viewer window. Here, you can view the photo-
graphs one by one at full resolution as well as per-
form basic editing functions, such as resizing,
rotating, cropping, and printing. The arrow but-
tons in the toolbar provide a way to step between
photographs in the album.
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GPHOTO2

The magic of reading images from your digital
camera under Linux is done in the background
by a piece of software called gPhoto2. This all is
transparent and hidden behind digiKam’s
friendly face. As I write this, gPhoto2 currently
supports over 530 different digital cameras. To
find out if your camera is supported, check out
http://gphoto.org/proj/libgphoto2/support.php
for the current list.

Figure 3. Adding a Camera Figure 4. digiKam Tags Window
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The Image menu in the main digiKam
window provides several additional options
for working with your photographs, one of
which is to edit the tags associated with an
image. A tag is a descriptive category that
can be attached to one or more photographs
as labels. For instance, we might choose to
tag all pictures of pets with a tag called (cre-
atively) Pets. Then, simply by clicking on the
Pets tag in the main digiKam window, all the
photos of our animal companions appear as
if they were in the same album. A photo-
graph can have as many tags associated with
it as you like, and photographs in different
albums can share the same tags. This is a
very handy organizational tool that provides
multiple ways of categorizing photographs
for quick viewing later.

Although digiKam starts with a basic set
of tags, new tags can be added by selecting
the New Tag option from the Tag menu. New

tags appear in the list on the left side of the
digiKam window as they are added. Tags can
be assigned to images by clicking on an
album and then selecting Edit Image
Contents and Tags from the Image menu.
This brings up the tag editor window, which
allows you to add comments and tags to the
photographs in an album. You also can drag
and drop photographs onto the entries in the
My Tags list as a quick way to add tags.

THE DIGIKAM TOOLBOX
digiKam offers much more than download-
ing pictures from your camera and arrang-
ing them into albums. It also provides a
number of powerful tools for working with
your photographs, and it is here that
digiKam really shines.

For instance, in the File menu, an Export
submenu where a selection of tools that
make sharing and backing up your photos
quite easy is found. A CD/DVD creation
wizard steps you through creating a CD-
ROM, complete with a Web browser-
friendly table of contents and navigation,
from your photographs. The HTML Export
tool also found in this menu lets you create
photo galleries with merely a few clicks
that can then be uploaded onto the Web.

With a color printer, it’s quite easy to make
nice photo scrapbooks in digiKam. Select one
or more photographs in an album, and then
select Print Wizard from the File→Export
menu. This wizard steps you through the
process of printing out photos in various sizes
and layouts. Perhaps even more impressive is
the Create Calendar wizard found in the Tools
menu. This wizard creates photo calendars

from your digiKam albums that can be print-
ed out right at home. These make wonderful
gifts for friends and family alike.

If you don’t have a color printer or want
to send the results electronically, select Print
To PDF as the printer name in the print dialog
to create versions of your albums and calen-
dars that can be viewed and printed on most
Linux, MS Windows, and Macintosh comput-
ers. These files are perfect for e-mailing to
family, friends, or taking to a print shop.

The Tools menu also houses several
other useful items, such as the slide show
creator and the image duplicate finder. But
perhaps the most powerful and useful
tools are found in the Batch Processing
submenu. As the name implies, these tools
work on several images at once. You can
rename, resize, and covert entire photo
albums of images quickly from this menu.
Tools for sharpening, adding borders, and
applying various image effects such as
embossing also are available from the Tools
menu. In all, more than 30 different batch
processing options are available in digiKam.

ELEGANT BUT POWERFUL
Getting images from a digital camera onto
a computer, a CD, or the Web has never
been so easy on Linux as it is with digiKam.
Whether you take photographs for fun, as
a way to record memorable events, or as
part of your work, digiKam’s straightfor-
ward interface and powerful processing
tools make working with collections of dig-
ital photographs painless. This is one piece
of software every digital shutterbug cer-
tainly should check out.n
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Figure 5. Adding a New Tag

Aaron J. Seigo is a
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desktop issues within
the KDE Project.

             

http://www.tuxmagazine.com


What would you do if you lost your handheld? I know it bugs me
every time I’m an hour away from home and realise I left it sitting
in its cradle. It’s not only the computer, though, it’s the informa-
tion—appointments, contact details, shopping lists. Is it Tuesday
or Wednesday that I’m supposed to see the doctor? How can I
book a time with this client if I don’t know when I’m free? And
then there’s the nightmare—not only leaving the handheld in its
cradle, but losing the information in it. It would take weeks to
sort it all out. Of course, the handhelds come with tools to fix
that—you back them up to your desktop computer. The catch is
that the tools work for Windows and possibly Mac OS, and your
computer is running Linux.

There’s a solution, of course. Too many programmers run Linux
and have handhelds for a problem like this not to have a solution.
There actually are several good solutions, and the best three, in
my opinion, are KPilot, Gnome-pilot, and JPilot. KPilot and
Gnome-pilot link directly to KOrganizer and Evolution (a free
Microsoft Outlook clone) letting you synchronise your handheld
with your personal information manager application. JPilot has an
information manager of its own, mimicking the four primary
applications in PalmOS.

KDE puts KPilot in the Utilities menu. Look for the icon of a
Palm Pilot in a cradle and the name PalmPilot Tool (KPilot). To run
KPilot from the command line, or the Run option under the K
menu, use the command kpilot.

KPilot needs to be configured before you can use it to synchro-
nise your handheld. The configuration dæmon should start auto-

matically at login. If it doesn’t, run KPilot to make the dæmon
start.

Now that KPilot is set up, you can do your first synchronisa-
tion. Check that your handheld is in the cradle, then press the
Hotsync button. Your address book, calendar, and to-do list infor-
mation are added to the information in KOrganizer, and the
address book information is shared with KMail. KOrganizer also
does group scheduling, which is not itself synchronised to the
handheld, but calendar events and to-do tasks that are scheduled
within the group scheduler are synchronised.

Next, open KOrganizer. The to-do list items are on the left,
under a month-view calendar. On the right, is your to-do and cal-
endar tasks for the current week. Below that is your schedule for
the week. A normal menu bar and icon bar are at the top, and a
status bar is at the bottom. Hover your mouse over the icons for
tooltips that tell you what each icon is for. On the top right in the
icon bar is a symbol that looks a bit like an open book. If you click

Syncing a Palm to KOrganizer
with KPilot
Linux offers many tools to sync your PDA with your Linux desktop.
Jenn Vesperman details the use of one of those tools.

JENN VESPERMAN

17www.tuxmagazine.com

SUITED UP

NOTE:
This article uses
KPilot and
KOrganizer, which
work with most
PalmOS handhelds.
If KPilot and
KOrganizer are not
already installed,
you can install
KPilot and
KOrganizer with
your package 
manager. They are
in the kdepim pack-
age for Red Hat,
kdepim3-kpilot and
kdepim3-organizer
for SuSE, and kpilot
and korganizer
Debian packages.

Figure 1. KPilot Wizard
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on that, the address book opens.
Experiment with KOrganizer. Your Palm infor-

mation is preserved, but KOrganizer allows addi-
tional information to be stored with to-do, calen-
dar, and address book entries. Right-click on one
of the to-do items, and select edit. The title, prior-
ity, category, note, date, and time are preserved,
but you can see a row of tabs in the dialog. The
tabbed dialogs provide a host of additional infor-
mation you can store about each to-do entry, such
as attachments (similar to e-mail attachments),
percentage complete, and attendees (people who
also need to know about the to-do item).

Close the to-do dialog, and right-click on a cal-
endar event, such as a meeting. Select edit, and
look at the tabbed dialogs. Select Attendees, and
enter in people who normally would be involved
in a meeting. Either click the New button or the

Select Addressee button—the latter uses your
address book to provide you with a list of poten-
tial people for the meeting. Once you have at
least one person entered, you also can choose a
role and a status for each person. Decide whether
you want to mail this person with the meeting
information; if you select OK, a dialog box opens
and asks whether KOrganizer should e-mail the
attendees.

Now that you’ve played with KOrganizer a bit,
let’s go back to KPilot and synchronisation. KPilot
offers three types of synchronisation:

n Fullsync: synchronises everything and copies
everything to the backup directory, and it is the
slowest option.

n Fastsync: synchronises only the things that con-
nect to programs on the PC. It doesn’t copy to
the backup directory, and it is the fastest
option.

n Hotsync: synchronises changed data and copies
the changed data to the backup directory.

In addition, there is an option to back up the
pilot data to the PC or to restore from the PC
without synchronising with KOrganizer. The back-
up and restore options must be used with care, as
any information on the target system is overwrit-
ten by the information on the source. The List
Only option lists the databases on the Palm Pilot
but does not actually exchange data. There are a
lot of synchronisation options, but most of the
time, you will need only Hotsync, which is the
default. If you want to change your default sync,
a drop-down menu under Settings→Configure
KPilot→Hotsync can do it for you.

You may want to use Fullsync every month or so, to
be certain that everything on the handheld is backed
up properly. On the other hand, you may choose to
use Fastsync when you’re about to run out the door
and simply want to check that the appointment list
on your handheld is correct. To do these changes of
synchronisation type, either right-click on the KPilot
icon in your panel or open KPilot. Select the synchro-
nisation option from the Next Sync menu in the
panel icon or from the Hotsync button menu or the
file menu in KPilot. Then, press the button on your
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Figure 2. KOrganizer

Figure 3. Hotsync

TIP You also can install a new file or program
application to your handheld (these are

usually files with a .prc or .pdb extension).
Open KPilot and select the File Installer from
the icons on the left. Click on the Add File
button, which opens a file selector. Select
your file or application, click OK, and then
synchronise your Palm as normal.

TIP
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cradle to sync the palm. This changes the
next synchronisation, but leaves the
default unchanged.

If you lose information from
KOrganizer, you can restore it by syn-
chronising from the handheld. If you
lose it from the backup directory, you
can restore it with the backup synchro-
nisation option. If you lose it from the
handheld, you can restore it with the
restore synchronisation option. Then
there’s the real concern, losing it from
everywhere. The solution to that is to
include your handheld’s information in
your regular system backup.

With every synchronisation method
other than Fastsync, KPilot copies your
handheld’s data to the directory
/home/username/.kde/share/
apps/kpilot/DBBackup/handheld name/,
where username is your Linux user
name, and handheld name is the user
name in your handheld. To store your
handheld data as part of your regular
system backup, ensure that this directo-

The most common reason for the configuration wizard
to fail to locate your handheld is incorrect permissions
on /dev/pilot. If you have access to the superuser (root)
and are the only person who will be using your com-
puter, you can fix this yourself:

n From the K menu, select File Manager—Super User
Mode.

n Change the Location to file:/dev.

n Find and right-click on pilot, and select Properties. If
pilot isn’t there, you have other problems and will
need to fill in your device manually (discussed later
in this article).

n Look at the properties window. It should have a
Points to section, which lists the actual device to
which your handheld cradle is connected.

n Find and right-click on the device listed under Points
to, and select Permissions.

n Change the permissions so that Others is set to Can
Read & Write.

If that doesn’t fix the problem, you can fill in your
user name and device manually. Your user name must
match the user name listed in your handheld, which you
can find by pressing Home, then Hotsync on the hand-
held. The name should be in the upper-right corner of
the screen.

The next best solution is to enter the actual device
into the Device field of the wizard. If you use a serial
cradle, the device is somewhere in the series /dev/ttyS0
to /dev/ttyS3, depending on which serial port you’ve

connected to: the first port is /dev/ttyS0, the second is S1,
and so on. If you use a USB cradle, it will be /dev/USB0
or higher. USB cradles can be a problem, because
adding other USB devices can cause the devices to
renumber—a cradle that was USB0 before you added
your memory stick may be USB1 afterward. The ideal
solution for the USB renumbering problem is to have
your system administrator configure the USB dæmon to
link /dev/pilot to the handheld’s cradle. The method for
this depends on your USB dæmon.

The Device dialog contains a connection speed
option, which is relevant only to serial connections.
The default should be fine, but if you have trouble 
getting your handheld to synchronise, you may want 
to try a slower connection speed. You can try a faster
speed—any speed that synchronises successfully is
good enough.

KPilot also supports infrared or network connections.
Helpful information for these connection types is avail-
able from the Help menu, under KPilot Handbook. Check
both Device Setup and Special HotSync Questions.
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DEVICE SETTINGS

Figure 4. Properties for Pilot

NOTE:
/home/username/.kde is the usual
$KDEHOME environment variable. If
your data is not there, use the com-
mand env in a terminal window, and
look for the KDEHOME variable. Your
data is at $KDEHOME/share/apps/
kpilot/DBBackup/handheld name/,
where $KDEHOME is the value of
the KDEHOME variable, and handheld
name is your handheld user name.

19www.tuxmagazine.com

                                      

http://www.tuxmagazine.com


ry is included. If you lose the data from
both your handheld and your PC, you can
copy the contents of this directory from
your backup media, back to the PC, and
then use the Restore option from KPilot’s
File menu to restore it to your handheld.

With all the additional tricks and tools
KOrganizer offers, the combination of your
handheld and your desktop becomes more
useful than ever. The wizard runs you through
the setup, and synchronising is as easy as
pressing a single button. Your information can
be included automatically in your general sys-
tem backup, so there’s no reason to lose your
handheld’s information ever again. Now that
you know how easy it is, isn’t it time to set up
your handheld on Linux?

SAFE AND SOUND
As you can see, your Linux system provides
a number of options for making sure that
the information on your handheld stays up
to date with what’s on your system.
Furthermore, these tools, when used regu-
larly, should help to ease the quiet dread
that all users of a handheld secretly harbor,
that someday they will lose the little thing,
their schedules, their address books, and
everything else in between.

Hotsync, backup, and rest easy.n
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NOTE:
If you are working on a system that has
multiple users, you can use this technique
to check the permissions but you should
let your system administrator be the one
to change permissions.

Jenn Vesperman is a
strong advocate for
women in computing
and has been the
coordinator of
LinuxChix for several
years. She also has
written Essential CVS
for O’Reilly &
Associates, and she
works as a program-
mer, system adminis-
trator, and/or writer.
Jenn lives in Australia
and is owned by two
cats.

There should be a handheld icon in the
GNOME control centre that represents
Gnome-pilot. If it’s not there, install the
Gnome-pilot package. Evolution should be
in the Office section of the Gnome-foot
Applications menu. If it’s not there, install
the Evolution package.

Double-click on the handheld icon, or
add the Pilot Applet utility to the panel.
Doing either of these opens the dialog
Gnome Pilot Settings, with a Welcome to
Gnome-pilot! dialog heading. Click Next.

The first configuration is Cradle
Settings. See the Device Settings sidebar
in this article for advice on devices. Leave
the Name and Timeout options at their
defaults, and click Next.

The second configuration is Pilot
Identification. If you’ve ever synchronised
this pilot to a desktop computer, even a
different computer, leave the setting at
“Yes, I’ve used sync software with this
pilot before.” If you haven’t, set the user
name you intend to use with this Pilot.
Leave the ID field at the default. Click
Next, and let the wizard run its Initial
Sync. Follow the instructions, and GNOME
will retrieve the user name and ID from
the pilot or set it onto your pilot if it’s
new. Click Next when it’s finished.

The next configuration is Pilot
Attributes, which sets your backup

directory for your pilot information.
Leave the options as the defaults
(MyPilot and /home/username/MyPilot).
Click Next, and you reach the Success
dialogue. Click on Apply.

Double-click on the handheld icon in
the GNOME control centre again. You don’t
get the wizard, but instead you should 
see a dialog with three tabs: Pilot, Devices,
and Conduits. The Pilot tab lets you edit
the same information that is in Pilot
Identification and Pilot Attributes in the wiz-
ard, the Devices tab lets you edit the Cradle
Settings, and the Conduits tab is new.

The conduits set what happens during
a sync. Click on the conduits tab and set
the following:

n Backup Enabled.

n EAddress Synchronize.

n ECalendar Synchronize.

n EToDo Synchronize.

n Everything else should be left at the
default.

These settings will give you a backup and
synchronise your address book, calendar, and
to-do with Evolution. The backup is stored in
the location given in your Pilot Attributes
and can be saved as a regular file.

Gnome-pilot and Evolution
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Group scheduling is something of a buzz phrase these days, but
most of us don’t need a buzz phrase to help us with time man-
agement. What we need is a simple way to keep track of multiple
schedules with the least amount of fuss. KOrganizer has exactly
the tools needed to do it.

Like most people these days, I lead a busy and sometimes com-
plicated life. With a household consisting of two working adults
and two children with different school schedules and extracurricu-
lar activities, I often need an overview of who is supposed to be
where and when they need to be there.

My former calendar-keeping strategy could best be described
as “many notes and random pieces of paper on the refrigerator
door”. This strategy has proven to be remarkably poor. The notes
fall off fairly often, usually when my small daughter borrows the
magnets to put up her picture of Nemo the fish playing basketball
with Superman. I once found a note about a most-important
appointment in the freezer when I defrosted it—a month after the
appointment had been missed!

In an effort to reform myself, I started using KOrganizer a cou-
ple of years ago, and it has been a great tool. Keeping a calendar
only for myself is simple. I work partly at home and partly at the
office, but my calendar is usually fairly loose. I simply enter specific
meetings I must attend as events and any deadlines that are com-
ing up as to-do items. Then, I block out generally the “working in
the office” hours. All the left-over working hours, I’m plugging
away at home, trying to meet those deadlines and prepare for
those meetings. In the first screenshot (Figure 1), you can see a

The Secrets of Juggling Multiple
Calendars
Organizing one calendar is easy, but what happens when you have multiple calendars?
Lauri Watts shows you how to organize and even publish them on the Web.

LAURI WATTS

Figure 1. A Typical Work Week as Entered in KOrganizer
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typical week for me. If that were all there is to it,
however, this article would be much shorter than
it is.

First up in my list of people who need to be
tracked is my oldest daughter Sam. She’s in the
8th grade and has a convoluted class timetable,
involving assorted classes in assorted classrooms,
sometimes in different buildings. Then there’s the
study days, random days off school for unfath-
omable reasons, theme days, school dances, and
my personal favorite, the open-house days when I
get to go to school with her, and she spends the
entire day being horribly embarrassed that her
mother is there. All this needs to be tracked, and
in a better manner than keeping her timetable on
the refrigerator door. KOrganizer to the rescue
again!

CREATING AN ADDITIONAL CALENDAR
I could of course, simply put all the school events
into my own calendar, and that would work fine.
It is, however, rarely the most important thing in
my day to know that Sam has a Physics class at
12:10 on Monday, and it is simply visual clutter
when too much information is presented at once.
The answer, then, is to maintain her calendar sep-
arately.

In the lower left-hand corner of a KOrganizer
window, you should notice the label Default
Calendar. This is, obviously, the default calendar,
and unless you tell KOrganizer differently, it’s
where any events entered are stored. Pressing the
Add... button, however, presents the opportunity
to create a new calender.

Various interestingly named formats are listed
here, but what we want is a simple calendar file,
so I choose the Calendar in Local File option.
Choosing this lets me select a name and a file-

name. The name is the one
visible in KOrganizer, so I call
this one Sam’s Schedule and
save it as samsschedule.ics in
my home directory. Now I’m
ready to start adding things 
to it.

LATHER, RINSE, REPEAT
One of the key features to any
calendar, as complex as they
may be, is that some of these
events repeat. Take Sam’s
school schedule—although
Monday is completely differ-
ent from Tuesday, every
Monday is more or less the
same as the next.

Adding these recurring
events is about the most complicated task in
KOrganizer, but it’s still not very complicated. Add
an event as usual, by double-clicking somewhere
near the time you want, right-clicking and choos-
ing New Event or by using the toolbar—whichever
you find most convenient. In fact, this is a good
opportunity to try them all and figure out which
way is easiest for you, because a school timetable
has a lot of events to enter.

I put the name of the class in the Title field, set
the time, and enter any notes in the free com-
ment area below the times. I also like to add the
classroom number in the Location field; in case I
need to fetch Sam at school for an errand, I can
find her easily. I also make sure to set the time as
Free and that no reminder is set. One isn’t set by
default, but I once turned them on without think-
ing, and as little as I need to know that she has
that Physics class on Monday afternoon, I need

even less to have a loud alarm sound reminding
me of the fact.

Next up is to switch to the Recurrence tab and
set up the recurring event. As you can see from
Figure 2, the combinations are nearly endless.
Mostly though, once you’ve enabled recurrence,
you need to worry only about two things: how
often it happens and when it stops. In this case, I
know that the 2004/2005 school year ends in the
first week of June 2005, so I add the date to the
End by: field. I also happen to know that the first
week of November is a school holiday, so I added
that to the Exceptions section while here.

You can be as careful with exceptions as you
like, adding each and every one, so that your cal-
endar is perfect. In this case, because it happens
to be the first week of November as I’m writing
this, it’s not very hard for me to remember to add
it as vacation while I have the dialog open. I know
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Figure 2. Editing an Event
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there is also a school holiday around Christmas
time, and one somewhere in March or so. I
could go look them up, but I find subtle clues
like the phone being busy all day instead of only
in the afternoon tend to tip me off to Sam hav-
ing a vacation, without the need to check that
in my calendar. Just because there is a field for
you to fill in, doesn’t mean you have to. Such
space for additional information is there if you
want it, and it can be ignored completely if it
isn’t useful to you—the goal is to simplify your
life, not complicate it.

Now that we’re all done with the first class of
the day, we simply click OK. And an unexpected
dialog pops up. Why? Because we now have two
calendars, and KOrganizer wants to know in
which one you mean to save this item. If I had
only one or two things to add, I simply could pick
the right calendar from the list given and move
on. Doing this can become tedious though, so if
you have a lot of entries to add to a specific cal-
endar, the easiest way to avoid being asked all the
time which calendar you meant is simply to
uncheck the box next to all the other ones. If
there is only one calendar that you save entries in,
it’s automatically the one KOrganizer uses.

Setting up something like a class schedule
takes a small time investment. It took me about
a half hour to enter them all, including end
dates, room numbers, and figuring out the
cryptic class codes used in the school schedule,
so that I actually knew what to call things. I
estimate it has saved me far more than that
already in the past week. For instance, I didn’t
have to rush around trying to get gym clothes
organized in the morning before school, having
checked the calendar the evenings before and
noticed they were needed.

ORGANIZING THE SMALL FRY
Next up is my youngest daughter, Kajsa. Her cal-
endar is much simpler. She goes to preschool 15
hours a week, and I get to pick which 15 they
are. Like most small kids, she likes routine, and
routine is certainly easier for me, and adding her
schedule to KOrganizer is a snap compared to
her big sister’s.

Now I have three calendars, and I simply can
uncheck the box next to Kajsa’s Schedule and
Sam’s Schedule to revert to my nice uncluttered
calendar view. When I want to plan for appoint-
ments, for instance, schedule a meeting at the
office on the days I’m not normally there, I sim-
ply can check the box again and see the two
schedules at once. What if I get an e-mail asking

me to move that meeting I had planned for
Monday to later in the week? I can see that I
don’t want to set it for Thursday, because both
Kajsa and I were supposed to be home that day,
and I have a deadline on Friday that probably will
keep me busy that day, so I move it to
Wednesday, during my usual office hours.

The calendar is looking
rather busy and cluttered at
this point, so you probably
can see why I don’t want to
overload myself with all this
information all the time.
Scheduling appointments for
the kids, though, is where it
really pays off.

For instance, I just got the
children’s annual dentist
check-up reminders, and I
need to schedule an
appointment for each of
them. It makes the most
sense to have them together,
so I turn on both kids’
schedules, and I quickly can
see that Wednesday morning
is good—I’m free, Kajsa is
home, and Sam has a long
break between her first and
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Figure 3. Viewing Three Calendars

Do you need fast access to a calendar? 
Left-click on the clock applet in the

lower right-hand side of your panel and a handy
little calendar pops up. You can jump month to
month or year to year with a single click. Left-
click again and the calendar disappears.

TIP
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second class. Because the dentist office
is only a block away from her school,
that’s perfect. Kajsa and I can meet her
at school, visit the dentist, and have her
back in time for her next class.

Unfortunately, a phone call to the
receptionist tells me that Wednesday
morning is booked solid, but there is a
spot free at 10:30 on Thursday—with
KOrganizer still open, I immediately 
can see that appointment fits in just as
perfectly, so I booked the time. I’m sure
the girls will be immensely pleased! For
this kind of thing, I simply block that
time into my own calendar, and I can
turn off the other two, safe in the
knowledge that disorganization and
tooth decay have been held at bay for
yet another week.

AND NOW WE SHARE
So far, it’s all been me, me, me. Time to
share the love, or at least, the calendars.
Sam is old enough to be checking for her-
self that she has gym clothes for the next
day or to make sure her homework and
textbooks are in her book bag for all the
lessons she has tomorrow. On the other
hand, I don’t necessarily want her editing
her school schedule or adding her shop-
ping dates with her friends to it. This turns
out to be quite simple. She also keeps her
own calendar, with what’s important to
her, and I put the school schedule I just
made into a shared folder on our file server
that everyone can read.

Moving the calendar from my end is
simply a matter of selecting it, choosing

edit, and editing the file location.
KOrganizer copies the file to the new
location. This leaves the older version
intact, in case something goes wrong,
such as you gave a location that you don’t
have write permissions for. You simply can
delete the old file, or you might want to
keep it as a backup.

From Sam’s end, she simply chooses
Add..., exactly like I did when creating a
calendar, but instead of inventing a file-
name, she can browse to the shared folder
and choose it there. Because she can’t
edit it, she can check the Read-Only box,
so that when she adds items to her own
calendar, KOrganizer doesn’t have to ask
her which one or try to write to a file she
can’t edit.

Now we can get even smarter. A cou-
ple of Sam’s school friends use KDE, and
they have the same class schedule. If I
put the calendar file somewhere accessi-
ble on the Web, they also can use it.
They don’t even have to download it
locally—KOrganizer happily loads up a
file directly via a Web link, and you even
can tell it how often to check back and
reload it in case of changes. For the
school schedule, that’s not until the end
of the school year, so it’s sufficient to
load the file once when KOrganizer
starts. For something less static, like my
work schedule, it might be more useful
to check it once an hour in case I added
a new appointment.

GETTING DOWN TO BUSINESS
You probably already can see how this

feature is useful for a small office, where
people usually don’t need to set up
appointments for one another, but do
need a way to see when everyone else is
busy or out of the office.

I’ve already used the examples of a
shared directory on a file server, and a
Web server, but you also can load calen-
dars from almost any kind of remote
source. This includes FTP servers, using
KDE’s fish:// protocol to access a remote
machine using ssh, or using webdav if you
have it available. You even could use the
kpf applet (KDE’s personal file server) in
the panel to share your calendar directly
via a local Web page.

Do consider the privacy implications
of making your calendars publicly acces-
sible. You probably will need to protect
them in some fashion, by placing them
in a directory that is accessible only from
the local network or by using a pass-
word. It’s also worth your time to think
about backup strategies. Burning a copy
of the calendars to a CD-RW once a
week or keeping an archive of them on
another machine are probably sufficient
for most situations

A final option for sharing calendars is
perhaps one of the simplest. KOrganizer
provides a nice export to HTML (you can
find it under the File menu). It’s highly
configurable, allowing you to choose the
span of time to export, whether or not
to show to-do items, among other
things. If you need to share a schedule
with a broad group of people, nothing
beats a Web page.n
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So, it’s early in the morning, and you decide to
read your newspaper. You pick it up and flip
through it a bit. The International section falls out.
While trying to put it all back together, it decides
to explode out the other side.

Have you ever noticed how Internet news
seems to do the same thing? If you’re like me,
you visit ten or more news sites a day. When you
go to them, you find either that they don’t have
anything new or that nothing interests you.
Wouldn’t it be nice if your news sites patiently
stood in line, and one at a time told you their
headlines? Then, if you ever wanted to hear more,
you could stop the parade and ask. That’s exactly
what KNewsTicker can do for your KDE desktop.

KNewsTicker is a desktop applet that’s part of
KDE. It shouldn’t take any extra installation to get
it going, because it’s included in recent versions of
KDE. It can go pretty much anywhere on your
desktop, including as a part of your standard
Kicker (the panel at the bottom of your screen).
As pictured below, it’s on a separate panel below
the kicker.

To set up KNewsTicker like this, you first need
to add a child panel to your Kicker so that it has
somewhere to go. Click on the small arrow above
the divider as shown in Figure 1, and then navi-

gate to Panel Menu→Add→Panel→Child Panel.
This creates a new panel along the left side of

the monitor. Click on the panel and drag it toward
the bottom center of the screen (Figure 2).

This places the child panel below the main
Kicker panel. Because it doesn’t need to take up
as much space as it does by default, set its size to
tiny by right-clicking on the child panel, and then
clicking Size→Tiny (Figure 3).

Up-to-the-Minute News, 
on Your Desktop
The Internet has brought access to news a click away. But, the sheer volume has created 
an organizational disaster. KNewsTicker will help you get the news you want under control.

KEVIN BRANDES
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Figure 1. Adding a Child Panel

Figure 2. The New Panel

Figure 3. Adjusting Panel Size
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Now that the panel is all set up, it’s
time to add KNewsTicker. Right-click on
the new child panel again, and select
Add→Applet→KNewsTicker (Figure 4).

Now you should have a list of head-
lines scrolling to the left at the bottom
of your screen, exactly as in the first pic-
ture. If one of the headlines interests
you, simply click on it, and a new
Konqueror window opens up with the
news story in question staring you in
the face. Isn’t that better?

Although that’s all fine and dandy, it
won’t do you much good unless it can
show you the news you’re interested in.
To configure KNewsTicker to grab the
news from your favorite sites, right-click
on the ticker itself, and select Configure
KNewsTicker (Figure 5).

In the new window that pops up,
you can change many facets of
KNewsTicker’s behavior. To change
where KNewsTicker gets its news,
click on the News Sources tab. A
bunch of news sources are listed here
already, and if one you want to use is
there, all you have to do is check the
box next to it, and KNewsTicker will
place it in the line of news sources
once you click OK at the bottom right
of the window (Figure 6).

If your favorite site isn’t on the list,
it’s a bit more complicated. Click the
Add button toward the bottom right of
the window. Now you’re going to need
the location of the site’s RSS feed.
Most sites that have an RSS feed try
not to hide that fact. For instance, if

you run a search for RSS on
http://www.time.com using their search
tool, you’ll find a page of links to their
RSS feeds. This page is located at
http://www.time.com/time/nation/
article/0,8599,635219,00.html at the
moment, if you’re having trouble find-
ing it. If you click on the Top Stories
feed, you’ll be staring directly at the
RSS feed. Copy the location of the
page you’re viewing, and place it into
the Source File field in the Add News
Source window by highlighting the
address, right-clicking, selecting copy,
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Figure 4. Adding KNewsTicker

Figure 5. Configure KNewsTicker

Figure 6. News Sources

Figure 7. Adding a News Source

Got a mouse with a scroll wheel? Here’s a great trick to 
try out. With your mouse cursor over the KNewsTicker

applet, rotate your mouse wheel up or down. Scrolling down
with the mouse wheel speeds up the flow of news, letting you
quickly scan through the headlines. Scrolling up slows down the
feed and even reverses it, in case you missed something.

TIP
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right-clicking on the Source File field, and
selecting paste. An example of what your
Add News Source window should look
like is shown in Figure 7.

Once you click OK, your news source is
added to the list of available news sources
and already is checked for inclusion in the
news parade. Once you click on OK for

the main configuration window, you will
see headlines from your new news source
scrolling happily along the bottom of your
screen.

So, now that you know how to make
KNewsTicker show you the news you want
to read, let’s see how to make it fit into
your life, instead of forcing you to deal

with what it wants to do. The screenshots
I’m showing you are from a laptop com-
puter. I really don’t have much screen
space, so I’d prefer that the headlines not
always take up my precious space, unless
I’m interested in reading them. One way of
accomplishing this is to have KNewsTicker’s
panel hide itself.

Click on the arrow pointing up, on
the left side of the child panel, and
select Panel Menu→Configure Panel
(Figure 8).

In this new window, select the Hiding
tab, and click the circle next to Hide
automatically (Figure 9).

Click OK toward the bottom right 
of the window. Once you click on your
desktop, it should look like you never
added a child panel or KNewsTicker in
the first place. When you want to see
your news headlines, all you have to 
do is move your mouse cursor to the
bottom edge of the screen, and
KNewsTicker slides up from the bottom
edge. This trick can be done with any
panel, not only with the KNewsTicker
panel (Figure 10).

I hope this article helps you enjoy your
Internet news surfing a little more. You
can configure KNewsTicker in countless
ways to suit your needs—don’t be afraid
to poke around. Until next time, keep
that newspaper in one piece.n
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Wouldn’t it be nice if your

news sites patiently stood in

line, and one at a time told

you their headlines? Then, if

you ever wanted to hear more,

you could stop the parade and

ask. That’s exactly what

KNewsTicker can do for your

KDE desktop.

Kevin Brandes is 21
years old and is
proud to help others
join the Open Source
movement. He lives
in rural Oregon with
his partner of three
years, where he
studies Software
Engineering.

Figure 8. Configure Panel

Figure 9. Hiding the Panel

Figure 10. The
KNewsTicker
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So you’ve got your Linux system installed and your
shiny new KDE desktop looks great. You are just
beginning to enjoy your experience when some-
one starts asking probing questions: maybe they
want to know your IP address, how much memo-
ry your system is currently using, or even what
type of processor you have. To most folks, what is
inside that box you’ve paid all that money for is a
bit of a mystery. Do you reach for the screwdriver,
or panic that you may be forced to learn the
dreaded command-line interface?

Don’t worry, help is at hand in the shape of
the KDE Information Center. This useful little tool,
supplied as part of the base KDE installation,
answers all these questions and more.

The first thing is to find this little gem. On
my SuSE 9.1 Pro system, it can be found in the
menu system as K→System→Monitor→Info
Center. I looked on a couple of other distribu-
tions, and it appeared under K→System→Info
Center. If you can’t find it in the menu system,
all is not lost. Simply bring up the Run
Command dialog box (pressing Alt-F2 does this
or using the menu system K→Run...), type the
program name, kinfocenter, and press Run.
You should be greeted with a screen something
like that shown in Figure 1.

This main screen gives a short description of
all the different types of information available.
You can drill down into any of these areas by
clicking on the hypertext link for each of the
types or on the name field in the index tree
panel on the left-hand side of the window. Some
of the types of information is a bit technical, so
let’s look at some of the least scary options first.
Click on the Processor link, and you’ll see more
information than you’ll ever need about the

beating heart of your system. Figure 2 shows
what I see on my laptop.

I’m pleased to see that what is actually inside
the box is what was advertised when I bought it.
I’m also intrigued by the fact that although this
is a Pentium M 1.7GHz, the CPU MHz is reported
as somewhere just short of 600. And what on
earth are BogoMips? Now, I did say that it would
be easy to get the information, but I never prom-
ised that the information provided always would
make sense or be easily understood. (For the
insatiably curious among you, the frequency
difference is due to the fact that I’m writing
this in Starbucks, on battery power, and my
CPU has been scaled back to the minimum 
frequency to conserve power. And BogoMips?
These are a rough estimate of processor speed,
explained fully in a How-To document at 
http://www.ldpmirror.ssc.com/HOWTO/BogoMips.)

USB DEVICES
The next thing we look at is how to find out more
details about all those other devices you have
plugged in to your machine. You know what I
mean—printer, scanner, digital camera, USB mem-
ory stick, DVD burner, and so on (that’s my inven-

Hardware Discoveries with 
the KDE Information Center
Want to know all about your hardware? The KDE Information Center goes way beyond 
what you can find out from the specification sheet or by grabbing a screwdriver.

PHIL NELSON

Figure 1. KDE Info Center

Figure 2. Processor Information
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tory as I look around me—yes, I’m back home
now). All of them are plugged in to USB ports, or
in some cases Firewire (IEEE 1394), parallel, or
serial ports.

You also know that each of these gadgets came
with a CD with drivers on it, and you never could
find anything on them relating to Linux. Never
fear—simply file those CDs away in a safe place in
case you should ever need them. Modern Linux sys-
tems support the vast majority of hardware straight
out of the box, without the need for any additional
driver disks. And, the Information Center allows us
to see more detail than we’ll ever need about the
internals of these devices. Take a look, for example,
at the screenshot of the USB tab (Figure 3).

I’ve just plugged in to the two USB ports on
my laptop my Jumpdrive (a little USB Flash memo-
ry device) and my Olympus digital camera. You
can see that Linux has identified both of them
correctly, without any external assistance.

It gets even better, however. When I plugged
this little beauty in to my USB port, Linux didn’t
merely identify it correctly, but it made it instantly
available for use by calling its hotplug facilities. If I
switch to the Storage Devices section of the
Information Center, I see two new devices on the

menu, matching the Jumpdrive and the camera. In
this case, the new devices have been made avail-
able as /media/sda1 and /media/sdb1. This varies
depending on what distribution you are using;
here, I was using Ubuntu Linux. We are given
information about the device, mount point, total
capacity, and free space.

I should explain what I mean by device and
mount point. On a Linux system, almost every-
thing is represented as a file. This may sound a bit
weird at first, but it actually makes dealing with
Linux systems easier for everyone, from developers
to end users. Every item of hardware attached to
the system is associated with a special type of file
known as a device. Normally, all the available
devices are found under a directory called /dev. In
times past, you used to have an entry here for
every possible device the system could support.
On more modern systems, entries are added to
/dev as needed. The device is a very low-level
interface to the piece of hardware. When the
hardware is a storage device, such as a disk, you
don’t want to deal with it at this low level. By
telling Linux the filesystem type to use and giving
it another location in the directory structure
through which to access it, you can see the disk
contents in the more normal mode of files and
subdirectories. This process of associating the low-
level device with a position in the directory struc-
ture is known as mounting, and the position you
choose for attaching the device is known as the
mount point. Linux supports not only its own
filesystem types but almost every other type of
computer filesystem ever invented. Thankfully, the
process of identifying the file type, working out a
suitable mount point, and doing the mount is all
taken care of by modern Linux distributions.
Normally, you’ll find removable devices under

either /media or /mnt.
So, where did Linux get the names sda1 and

sdb1? This is another good example of how the
designers of Linux have used a degree of abstrac-
tion to make life easier for everyone. The sd is an
abbreviation for SCSI Disk. “But”, I hear you say,
“you plugged your Jumpdrive and camera in to
USB ports didn’t you?” Quite correct, but you’ll
find that USB disks (also disks, CDs, and DVDs
plugged in to Firewire and parallel ports) are treat-
ed as if they were SCSI disks. This saves having to
write multiple sets of code to do virtually the
same thing, making the task of maintaining the
system and adding new devices simpler.

And now for the pièce de résistance: click on
one of the devices (Figure 4) and a little menu
appears. One of the options is labeled Open in File
Manager. Choosing this opens KDE’s file manager,
Konqueror, and you immediately are able to work
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Figure 3. USB Devices Figure 4. Storage Devices

HISTORICAL NOTE:

The expression, “Everything is a file”, is a rather
famous line and one you may encounter more
than once in the Linux (and UNIX) world. The
quote is attributed to Ken Thompson, the origi-
nal developer of UNIX.
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with the files on your device just as you can any
other device.

The SCSI and IEEE 1394 (Firewire to the rest of
us) tabs on the Information Center work in an
equivalent way to the USB tab we just looked at.

MEMORY: A NUMBERS GAME
The next information we look at is the Memory
tab of the Information Center. Figure 5 shows the
current state of my laptop.

It’s good to know that I actually have some
memory free. I guess some things need an expla-
nation, however. Physical memory is the amount
of RAM (random access memory—the memory
chips inside the machine) that is available. But, the
total amount of memory available to the system is
greater than this. An area of the hard drive, called
swap space, is set aside to augment the physical
memory when it becomes exhausted. When I
started using Linux, the recommendation was that
you should set aside an area of disk twice as large
as your physical memory for swap space. As mem-
ory became cheaper, the ratio recommended
decreased, and currently I’m running with a swap
file size of 1GB of memory. And, even that is

probably excessive, as I’ve never seen any of it
being used. The next thing you should notice is
the large green area labeled Disk Cache. Because
reading from memory takes an order of magni-
tude less time than reading from disk, Linux holds
recently accessed disk pages in memory if physical
memory is available. Then, if you need that page
again, it is accessed much more quickly.

IP ADDRESS: YOUR HOME ON THE INTERNET
Now, let’s move on and look at the Network
Interfaces tab. Sooner or later someone is going
to ask you something like “What’s your IP
address?” Your response to this might well be
“What is an IP address?” Let me briefly explain.
When a computer attaches to the Internet, or any
other network, it has to have a unique identifier,
its IP address. If you are not permanently connect-
ed to the Internet (for example, if you are have a
dial-up connection), your ISP normally allocates
you an IP address from a pool, so you are likely to
get a different IP address every time you connect.
Often, if you are having difficulty with your net-
work connection, you’ll be asked for this informa-
tion. Network connections also are given a name,
based on the type of connection you are using.
For example, dial-up connections (using a protocol
called PPP) normally are called ppp0, whereas a
LAN connection (Ethernet) normally would be
eth0. You also should see a special type of net-
work connection called lo, the loopback interface.
This is a virtual network connection back to your
local machine and is used by many programs to
send information back and forward internally.

RIDING THE PCI BUS
We’re going to end with a look at the tab labeled
PCI. Inside your machine, all the devices need a

way of moving data back and forth. It’s a bit like
the highway network—if we didn’t have high-
ways, it would be much more difficult to get from
one place to another. This highway inside the
computer for the interchange of information is
known as a bus. And just like a real highway,
everyone has to stick to certain rules or there
would be chaos. The PCI standard is the set of
rules that nearly everyone uses. Every device that
wants to send or receive data is given an identifi-
er, which is then used to ensure that the data
goes to the right place. After all, it wouldn’t be
much use if you tried to send a file to your printer
and it ended up getting delivered to your
sound card. Listed under the PCI label is every
device that has made itself known to the PCI
bus. A look down there will satisfy even the
most curious people’s desire for information
about what is inside their machines—a lot of
detailed information is given.

So, that brings us to the end of our little tour.
A few tabs have not been covered here, which are
beyond the scope of this introductory article.
However, I hope you now have all the information
at your fingertips that you’ll need next time any of
these probing questions are asked.n
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Figure 5. Memory
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I haven’t seen the surface of my desk in about
two months. Three layers of documents litter
my work surface, along with assorted tools like
a calculator, a couple of writing pads, a diction-
ary, a stapler, and a telephone. It’s not that I’m
normally a messy person; I simply don’t have a
desk big enough to permit me to organize my
materials properly. It doesn’t help that I have
three projects on the go at any one moment
and need quick access to just about everything
on the desk.

I keep my computer desktop in much better
shape. I have the same problem of too many doc-
uments open at once, all important enough to
keep readily available while I work. The good
news is that I have a number of virtual desktops
on my computer, so I can spread my work out.
Even better is that each of these virtual desktops
hides away when I don’t need it, so I don’t see
the clutter but always can get to something with
only a mouse click or two. Let me show you what
I mean by virtual desktops.

VIRTUAL DESKTOPS
If you look at a Linux desktop, it looks like the
working surface of a real desk. With a window or
two open in the foreground, and few minimized
windows, it’s not yet cluttered or unusable. But all
it takes is a few more open windows and this
neat desktop can start to look more and more like
a real, cluttered desk.

But a standard Linux desktop has something
special, virtual desktops. It’s like having your work-
ing surface spread across multiple monitors, but
without the extra hardware. With virtual desktops,
you can have several separate work areas available
at your fingertips, and you can spread all those
open applications across them. The trick is that
you work in only one of these areas at a time, and
the rest of the areas are hidden away from sight.

Your working desktop has all the normal icons
and menu bars that you’d expect it to have.
However, it only has those windows you’ve explic-
itly opened or moved to that desktop. All of the
other windows you have open are hidden and
show up only when you change to one of the
other virtual desktops. You can think of this as
having several desks, but being able to see only
one desk at a time.

In KDE, the panel supports a Pager applet that
gives you an overview of your virtual desktops.
These show up as four squares labeled 1 through
4 (Figure 1). Some distributions start you off with
only two virtual desktops, but I’ll show you how
to change that shortly.

Click one of the buttons of the Pager applet,
and KDE switches to display the desktop associat-
ed with that button. Click on another Pager but-
ton, and you move to a different desktop, and the
windows associated with the previous desktop
disappear to be replaced by the windows associat-
ed with the new desktop. Don’t worry, though;
the old windows still are open and active. They
simply are now on a desktop that’s been hidden
from view. Any windows opened in the virtual
desktop stay with that desktop until they either
are closed or moved.

The number of virtual desktops is configurable
through the configuration context menu. Right-
click on the virtual desktop applet in your panel
and select Configure Virtual Desktops. A window
appears from which you can select additional vir-
tual desktops. You even can give them individual
names at this point (as opposed to numbers).

The window manager also provides a win-
dow context menu option (usually through a
right-click of the window title bar) that allows
you to move the associated open window to a
new desktop. This context menu option gives
you a list of the virtual desktops available, and
the desktop you select here is the one on

Clear the Desktop Clutter 
with Virtual Desktops
One of the greatest tools available to desktop
Linux users sits quietly in your panel, two or more
unassuming squares just waiting to be unleashed.
Learn to harness the power of virtual desktops, and
you’ll wonder how you ever lived without this
easy-to-use application.

LEW PITCHER

Figure 1. The KDE Pager Applet
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which your window appears.
With these two tools (the pager and the

context menu), you can unclutter your
desktop by moving related windows to
their own virtual desktops, out of sight but
readily available. Unfortunately, there still is
one problem to conquer: how do you find
a window once you’ve moved it off of your
current desktop?

WHERE, OH WHERE, DID MY WINDOW GO?
Some environments have tools that give
you a miniaturized view of all your virtual
desktops. These viewers usually repro-
duce the contents of all the windows, on
all the desktops, in miniature. The KDE
Kpager tool serves this function, but
unlike the Pager applet, Kpager sits on
your desktop in its own window (Figure
3). This window sticks to your desktop so
that, no matter which virtual desktop you
move to, you always have a detailed
visual reference to all the available desk-
tops. To start the KDE Pager, right-click
on the virtual desktop applet in your
panel and select Launch Pager from the
pop-up menu.

GETTING FANCY WITH KOMPOSÉ
Advanced users who want more than
what Kpager offers, should take a look
at Komposé, written by Hans Oischinger
and hosted by the BerliOS Project at
http://kompose.berlios.de. Similar to the
view through OS X Exposé, Komposé builds
a composite view of all your desktops into
one big window that takes up the whole
screen. Note that Komposé isn’t installed on
your system by default, so
this is a program you’ll
have to add on your own.

THROUGH THE GLASS,
CLEARLY
There’s no doubt that it
is difficult to keep your-
self organized when
working on many differ-
ent things at once, espe-
cially when space is lim-
ited. But, unlike the
world of paper and pen,
we can organize the
Linux desktop so that
there is a place for
everything and every-
thing is in its place. We

also have the advantage of tools like
Kpager and Komposé that can help us
find those concealed windows with little
effort. Get cozy with your virtual desk-
tops, and you’ll wonder how you ever
managed to work without them.n
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Figure 2. Desktop Selection in the Window
Context Menu

Figure 3. The Kpager Virtual Desktop
Viewer

Figure 4. The Komposé Mini System Tray
Icon

Figure 5. A Grouped Desktop View through Komposé
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Today, two desktop environments dominate the
Linux world, KDE and GNOME. In their standard
forms, both of them make it easy to perform 
virtually any computer task using convenient
graphical tools. However, they can be made
even more efficient if you take the time to cus-
tomize the various features for your specific
tasks and the way you like to work. After all, 
it is your desktop, and you should be able to
make it your own. In this article, we look at
some of the ways the features of the KDE work
environment can be modified and configured.
You will find that customizing KDE is very 
simple. In many cases, changing the way things
work is as easy as dragging an item from one
place to another.

KICKER, THE KDE PANEL
The toolbar that appears at the bottom of the
KDE desktop is actually called Kicker, but most
people call it the panel. The exact configuration of
the panel varies quite a bit between different
Linux distributions. Figure 1 illustrates the default
configurations currently provided by Red Hat Linux
(the uppermost panel), and SuSE Linux (the middle

panel), along with one of the customized panels
that I use.

The panel is constructed from a series of small-
er subsections, any and all of which can be cus-
tomized. The main parts of the panel are:

n The K menu, typically located as the panel’s
leftmost icon. The default icon is illustrated in
the bottom panel in Figure 1. However, as the
other two example panels indicate, distributions
often replace this default with one of their
own. Red Hat has a red fedora, and SuSE uses
a green chameleon face to provide the button.

n A series of application icons typically are located
to the right of the K menu. Once again, the
specific applications that are included differ
depending on the Linux distribution you’re
using. You also can add, move, or remove these

application icons.

n The Taskbar generally is located in the middle of
the panel. It is subdivided into a series of rec-
tangles, each of which corresponds to an open
application. You can decide whether you want
the rectangles for multiple instances of the
same application to be combined or to remain
separate within the Taskbar. The default is the
former. For instance, if you have three copies of
the OpenOffice.org word processor running,
the three instances will be combined into one
rectangle with a small down arrow indicating
that there are multiple programs running there.

n One or more additional applets—small pro-
grams designed to perform one specific task—
also may be present in the panel (for example,
dictionary lookup, weather applet, logout but-

Customizing Your 
KDE Work Environment
Although the Linux desktop comes with a default
configuration, it is very easy to modify it to better
address your needs. Æleen Frisch shows you how.

ÆLEEN FRISCH

Figure 1. The Default Red Hat and SuSE KDE Panels, Along with a Customized Panel
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ton, and so on). The illustration shows
quite a few of the possibilities.

There are many ways to customize
the KDE panel. You can change the
order and/or the size of the various com-
ponent sections by clicking and dragging
on the series of vertical or diagonal lines
or dots found on each one’s left edge.
You can change the size and/or place-
ment of the panel itself by right-clicking
on the panel and selecting Configure
Panel.

The panel’s right-click menu also pro-
vides an easy way to add or remove items
from it, by using the Add and Remove
items, respectively. Each of these contains
a submenu with the following items:

n Applet: allows you to add or remove
applets from the panel. Figure 2 illus-
trates some less-familiar panel
applets, and Table 1 describes the
most important applets currently
available (an asterisk and double
asterisk indicate applets illustrated in
Figures 1 and 2, respectively).

n Application Button: adds or removes
an icon for an application that is pres-
ent in the K menu (see below). You

also can add an icon for a K menu
application simply by dragging it from
the K menu to the application icon
section of the panel.

n Special Button: adds or removes
icons for non-KDE applications and
other system functions (for example,
browser bookmarks, printer configu-
ration and management, and recent
documents).

n Extensions: allows you to create addi-
tional panels.

When you are adding a new icon,
each of these items lists all of the avail-
able choices of that type. For example,
the Application Button submenu con-
tains all the application groups present
in the K menu. On the other hand,
when you are removing an icon, only
those items currently present in the
panel are listed in each submenu. That
way, you don’t have to sort through a
huge list just to remove something you
no longer need.
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Figure 2. Some Optional Panel Applets

TABLE 1. USEFUL PANEL APPLETS
Applet What It Does

Application Launcher** Runs a single shell command. The Alt-F2 key 
sequence performs the same function in the KDE 
environment.

Clock* Shows the time and optionally the date. Also 
includes a pop-up calendar.

Color Picker** The applet’s top icon (the eyedropper) can be 
used to sample any visible color; the RGB and 
HTML values are displayed and optionally can be 
copied to the clipboard. The bottom icon (the 
colored circle) contains a history of sampled colors.

Dictionary Looks up the definition of a word or phrase or 
searches dictionary definitions for a string. If your
Internet connection is always on-line, this is a 
great tool to have at your disposal.

KcharSelect** Copies special characters to the clipboard. The list 
of characters can be configured by the user.

Klipper* Provides access to the system clipboard.

KMix Applet Sound mixer applet.

KNewsTicker Displays clickable news headlines, mostly related 
to KDE.

Lock/Log Out Applet* Contains icons to lock the screen and to log out.

Media Control Play, Stop, Pause, and other buttons for 
controlling sound and/or video playback.

Pager (AKA Mini-Pager)* Switches between available virtual desktops.

Quick Launcher Contains tiny application icons, providing a more 
compact (Windows-like) alternative to the usual 
application icon collection.

System Monitor** Displays three bar graphs indicating current 
system CPU, memory, and paging performance data.

System Tray* Contains icons for various management functions.
Different Linux distributions tend to use this 
applet in different ways. For example, Red Hat 
Linux places an icon indicating whether there are 
any pending software updates, while SuSE Linux 
provides access to the volume control and power 
management facilities here.
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APPLETS
Some of these applets are covered in
greater detail elsewhere in this magazine.
Check out Lew Pitcher’s article on virtual
desktops for an in-depth look into your
panel applet’s capabilities. Then, stay up to
date on all the news that is news by using
the KNewsTicker applet, covered in Kevin
Brandes’ article.
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THE K MENU
I’ve already mentioned that the K menu provides access to a wide variety of
applications and other system functions. Figure 3 illustrates its structure as
well as its default configuration on Red Hat Linux systems. This is my way of
saying that your menu may look different than mine. Different distributions
may have things laid out differently. Default setups aren’t forever. For
starters, you easily can customize the top three sections of the menu.

The heart of the K menu is located in the second section from the top in
the illustration. This section of the menu provides access to virtually every
KDE-compatible graphical application present on the system. The various
applications are divided into groups by their general type. You can customize

the list of applications and their
orderings and groupings as exten-
sively as you like. The simplest way
to do so is to drag various items
to different locations within the
menu hierarchy. However, if you
want to make significant modifica-
tions to the contents or structure,
the menu editor utility is really the
way to go.

Start the menu editor by right-
clicking on the K menu and select-
ing Menu Editor. You also can
select K, then Run Command, and
type kmenuedit for the command
name. This menu editor is illustrat-
ed in Figure 4.

When you select an existing
menu component in the list box at
the left, you can drag it to a new
location, change its name or other
characteristics, using the fields in
the right half of the dialog, or
remove it using the corresponding
toolbar icon. You also can add
new submenus or menu items
using the toolbar icons. For exam-

ple, in the illustration, we
are adding a new item
named System
Performance Overview to
the System Tools group,
which will run the program
/usr/local/bin/xosview (this
is merely an example; we
could use any program we
want).

What about those other
two sections in the K
menu? Well, the upper-
most K menu section, as
well as the section immedi-
ately below the application
groups (the third section
from the top in Figure 4),
are customized using the
Menus tab of the panel
configuration utility (you
can reach it by right-click-
ing on the panel and
selecting Configure Panel).
This dialog is shown in
Figure 5.

The top section of the
dialog specifies which
items are included in the
Optional Submenus section
of the K menu. You can
select the items you want
on your menu by clicking
or clearing the check box
next to each one.

This dialog also allows
you to select whether the
applications listed in the
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Figure 3. The Structure of the K Menu

Figure 4. Modifying the K Menu

Figure 5. Configuring the K Menu’s Optional
Submenus and Used Applications Sections
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top section of the K menu are the ones that were
most recently used or the ones that are most fre-
quently used. You also can specify the maximum
number of applications that are included in this
section; specify a value of zero if you want to
eliminate the section altogether. Remember, it’s
your desktop and you can do as you please.

TIME TO ADD SOME DESKTOP ICONS
If that super-clean looking desktop is a little too clean
for you, have no fear. You also can make a variety of
modifications to the icons on the KDE desktop itself.
For example, you can rearrange the standard icons
simply by dragging them around. More sophisticated
rearrangement schemes can be performed by right-
clicking on an open area of the desktop to reveal the
desktop’s context menu and then selecting one of the
items from its Icons submenu.

Removing an icon is equally easy. Simply right-
click on the icon, and select Delete from the menu,
or select the icon, and then press Shift-Delete.

There are several ways to add new icons to the
desktop. If you want to add an icon for an appli-
cation that is included in the K menu, all you have
to do is navigate within the menu to the desired
application and drag it to desktop. When you

release the mouse button, a small menu consist-
ing of Copy Here, Move Here, Link Here, and
Cancel appears; select Copy Here in this case. The
new icon then appears on your desktop and is
ready to use.

Icons for other types of items can be created by
right-clicking in an open area of the desktop, select-
ing Create New from the menu, and then choosing
the desired type of item from its submenu. For exam-
ple, I like to have icons for CD/DVD-ROM and USB
Flash disk devices on my desktop, but the standard
configuration contains only an icon for the system’s
floppy drive. Creating the first icon involves right-
clicking on the desktop and then choosing Create
New→CD/DVD-ROM Device.

Figure 6 shows the dialog that results from this
selection. It has four panels, but I need to modify
only two of them in order to create my icon. In the
General panel, I specify the text I want to be dis-
played along with the icon. In the Device panel, I
select the device interface file corresponding to the
system’s CD-ROM drive. On most Linux systems,
the CD-ROM drive is preconfigured, so the proper
device is listed in the corresponding menu, and
you’ll be able to identify it without any trouble.

Creating an icon for a USB Flash drive involves
a similar procedure to that of a CD-ROM drive,

but it may require some special preparation (see
the sidebar for details).

Creating an icon that opens a folder also is
straightforward. If you want to create a new fold-
er on the desktop, you can right-click and select
Create New→Directory, specify the desired name,
and the new folder appears. (This action has the
effect of creating a subdirectory with the given
name under $HOME/Desktop.) If you want to cre-
ate an icon for existing folder, you can do so by
navigating to the desired location using the
Konqueror file browser, dragging the desired fold-
er onto the desktop, and then selecting Link Here.

Figure 7 shows the some of various forms that
desktop folder icons can have. The Home and
Start Here icons are provided by default on current
Red Hat Linux systems. They open Konqueror win-
dows for your home directory and a virtual direc-
tory containing a variety of commonly used items,
respectively. The other two icons in the illustration
were created in the manner just described. The
Articles icon corresponds to a new folder created
on the desktop, and the ae icon corresponds to
an existing folder. The green arrow on the latter
icon indicates that it is a symbolic link to the spec-

ified folder rather than a fold-
er that actually resides on the
desktop.

Many other kinds of icons
also can be created on the
desktop using different selec-
tions in the Create New sub-
menu. I am sure that you will
find it enjoyable to explore
the remaining options on
your own.
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When deleting icons from your desktop,
you also have the option of simply

dragging the icon to the trash bin. The trash
bin is essentially another folder from which
you can bring back things you deleted. If you
want to get rid of things but still want the
option of bringing it back (at least until you
empty the trash bin), choose this over Delete.

TIP

Figure 6. Adding a Desktop Icon for the 
CD/DVD-ROM Drive

Figure 7.
Varieties of
Desktop Folder
Icons
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SELECTING ALTERNATE ICONS
We’ll end this whirlwind tour of KDE cus-
tomization options by considering one trivial
but frequently requested item: modifying
the icon images associated with desktop or
panel items. In general, you can modify the
icon that is displayed for almost any item.

This is accomplished by accessing that item’s
properties (typically by right-clicking on it),
and then clicking on the large icon button
found within its configuration dialog, as
illustrated at the top of Figure 8.

The red arrow beginning at the icon but-
ton leads to the dialog that results when

you click it. The Icon Source dialog contains
two radio buttons. The first, System icons,
provides access to the collection of icons
provided with the operating system. They
are organized into a series of categories that
are selected using the pull-down menu.

The Other icons radio button provides
access to any additional available icons not
included within the system categories (not all
Linux distributions provide them). In addition,
you can use this selection to specify a cus-
tom icon file for an item. Clicking the
Browse button (hidden underneath the sys-
tem icon category menu in the figure) results
in the dialog in the lower-left corner of the
figure. You can use it to navigate to and
select the specific icon file you want to use.

Using custom icons is a lot of fun and is
one of the best ways to express your per-
sonality on your desktop. There are several
utilities you can use to create your own
icons if none of the ones provided with the
system suits you. Be careful, though, as
creating icons can be both incredibly time
consuming and addictive.n
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A few preliminary steps may be necessary in order to

create desktop icons for USB Flash disks, and these steps

must be performed by the system administrator. First, a

mount point must be created, as in this example:

# mkdir /mnt/usbdisk

# chmod 755 /mnt/usbdisk

Next, you must edit the filesystem configuration file,

/etc/fstab, and add a line like the following:

/dev/sda1  /mnt/usbdisk  auto  noauto,user  0 0

This entry specifies that the Flash disk should be

mounted at the directory we created in the previous

step, that its filesystem type should be determined at

mount time, that such disks will have to be mounted

manually, and that any user is permitted to mount

them (rather than limiting this ability to the root user).

The example entry uses the device /dev/sda1; this is

the interface file typically used by the first USB device

provided that there are no SCSI disks present on the

system. If your system contains SCSI disks and/or addi-

tional USB devices (such as a scanner), you’ll need to

change this file to the correct one for your situation.

Once these preliminary steps have been com-

pleted, you can create a desktop icon for the USB

Flash drive by right-clicking on the desktop, selecting

Create New→Hard Disc, and then modifying the

same fields as for the CD-ROM drive. Once the

icon has been created, you can right-click on it in

order to mount and unmount a USB Flash drive.

Double-clicking on the icon before you have

mounted the Flash disk results in a confusing and

essentially erroneous error message stating that

only root can mount it.

Finally, be aware that on some systems, USB

devices are handled in an altogether different

matter, through the Hotplug facility. The preceding

method may or may not work in such cases.

Mounting a USB Flash Drive

Figure 8. Selecting Custom Icons

ICONS FOR USB DEVICES
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Why do people surf the Web? That has to be one
life’s great questions—a question not too distant
from that other great life question, where did I
put my keys? Whatever the reason, Web
browsers, especially Mozilla ones, aim to help you
cruise the Web in style. They include all kinds of
nifty features designed to ease your travel from
this page to that. In this article, we take a look at
the Sidebar—one of the major helper features of
both Web browsers built by the Mozilla
Foundation. These two browsers are the Mozilla
Application Suite, which is at about version 1.7
these days, and the Firefox Web browser, recently
released and at about version 1.0. Other
browsers, like Konqueror, may adopt Mozilla tech-
nology soon as well.

It’s often said that using the Web is all about The
Search. To me, that’s a rather narrow view. When I
jump onto the Web, sure I’m looking for content,
but I’m also trying to connect together information
in a way that aids my creativity, fires my passion, or
completes my life-strategy-of-the-current-minute. At
least it fills a few colourless empty hours and staves
off boredom. Such activities are not as simple and
single-minded as “Did I find it yet?”, and so Google
and LookSmart can help only so much.

It would be nice if there was some kind of smart
parrot on your shoulder while you surfed the Web.
When hyperlinks don’t help, and you have more
bookmarks than you ever can find anything in, the
parrot would skwark: “Ship to starboard!” That
would break you out of your dead-end and stimu-
late you with some ideas from an alternate point of
view. Sidebars have a similar goal; they’re there to
complement the main activity that you do with the
browser, in a way that’s hopefully useful.

INTRODUCING THE FIREFOX SIDEBAR
Firefox comes with two sidebars installed, the
History Sidebar and the Bookmarks Sidebar. Here’s
a picture of Firefox with the History Sidebar
shown. Make it appear by pressing Ctrl-H or with
the View→Sidebar→History menu item (Figure 1).

In my case, I’ve installed Firefox under KDE just
today, so the list of my prior Web surfing is short
and covers only one day. Up to nine days of histo-
ry is shown with the default Firefox setup.

The Firefox History Sidebar is handy because of
its search function. When you know that you
recently visited a Web page relevant to your cur-
rent activities, but you can’t remember where it
was, it’s the History Sidebar to the rescue. You

Parrot on Your Shoulder: 
Exploring the Mozilla Sidebar
Hiding below the familiar face of your browser is one of the most underused tools at your disposal. Almost
every browser sports some kind of sidebar that sits waiting, only a keystroke away. Neglected? Perhaps,
but what precisely is this wonderful thing for? Nigel McFarlane explores the Firefox and Mozilla sidebars.

NIGEL MCFARLANE

Figure 1. History Sidebar

NOTE:
Sidebars aren’t unique to Mozilla browsers.
Konqueror has a hidden sidebar that you can turn
on and off by pressing F9. Opera, another popular
browser, has several configurable sidebars (or
panels, as they are called here). To show or hide
panels, click View and select Panels.

The number of days browser history is 
kept is controlled by a setting called

browser.history_expire_days. You can set that
preference using the page displayed by the
special URL, about:config. That system, which
allows you to change a huge number of inter-
nal browser settings, is an article on its own.

TIP

TUX EXPLAINS
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also can sort the recent history with the view but-
ton. Click any item in history to see it retrieved
into the main part of the window.

The Bookmarks Sidebar provides another dis-
play option for bookmarks. If you don’t like the
Bookmarks Toolbar, and you don’t want to take
up a separate window with the Bookmark
Manager, opening the Bookmarks Sidebar with
Ctrl-B is the way out. This display of bookmarks
also is made useful by search. If you’ve landed on
a Web page whose topic is close to your heart,
simply highlight a word with the mouse, move the
mouse cursor to the search box in the Bookmark
sidebar and middle-click. Any pages that you’ve
visited with the keyword in the title are listed
automatically. Click on any bookmark to display its
page, but don’t click on the bookmarks in the
Quick Searches folder. They have a special pur-
pose, which is to support keyword searches in the
main Location Bar (the spot where you type URLs).

BIGGER AND MORE POWERFUL—THE MOZILLA
SIDEBAR
The Mozilla Application Suite (MAS) is essentially
Firefox’s older sibling. This powerful application that
contains a browser, an e-mailer, Web page editor, and
chat client, also comes with a Sidebar. It’s integrated
with the Mozilla browser (Navigator) in a similar way
to the Firefox case, but it allows you to see the differ-
ent Sidebar options stacked as a vertical set of tabs.
Turn on the Sidebar by pressing F9, and select which
Sidebar tabs should appear by clicking on the Tabs
drop-down list at the top of the Sidebar panel. The
Application Suite is a larger product than Firefox and
comes with four sidebars instead of two. Figure 2
shows the powerful What’s Related Sidebar.

This Sidebar really has the spirit of a shoulder-
dwelling parrot. Whatever you have on display in the

main part of the window, the What’s Related Sidebar
reaches out over the Web and finds similar sites that
you might be interested in. It’s a sort of automated
referral system, except that those other sites are
referred anonymously to you, rather than the other
way around. If you’re on a dial-up link, What’s
Related can take up a bit of extra network time. You
probably want to use it only occasionally, not all the
time. When you’re shopping for specialty goods, and
you’ve found one Web site that you like, it’s a great
way of seeing who the competitors are.

Sometimes, the sidebar-tab action takes a bit
of getting used to. If you click on a tab, it doesn’t
go to the top. Instead, the set of tabs opens up
where the clicked tab is. The upshot is that some-
times sidebar tabs are displayed above the current
sidebar content, sometimes there’s tabs below
that content, and sometimes there’s both.

You can see in Figure 2 that four tabs appear at
the bottom of the Sidebar. The last of these,

Find/Book Travel, is a custom tab. It’s an extra that
has been installed separately to the standard Mozilla
products. For the older MAS browser, you can go
shopping for more sidebars by clicking on the Tabs
drop-down list and choosing the menu item Sidebar
Directory. Doing so reveals a Web page in a new
window—a Web page that lists zillions of potential
sidebars. The secret’s out—the sidebar also can be
used to display an ordinary Web page specially
designed to fit. The What’s Related Sidebar is an
example. To install one of these sidebars, simply
click on its link, and Mozilla does the rest.

Firefox doesn’t have a special Firefox Sidebars
Web page, but there’s somewhere else to shop.
Start the Extensions Manager or simply visit
http://update.mozilla.org. There, you’ll find a heap
of extensions that can be added to Firefox. Some
are menu items, some are toolbars, and some are
sidebars. To see what’s what, read the extension
descriptions. Some sidebar-enabled extensions
include cookiebar, oneclick, quicknote, and the
more developer-oriented editcss. If you can’t find
a given extension at http://update.mozilla.org,
have a look at http://www.mozdev.org, which is
where projects in progress often hang around
until they’re sufficiently polished.

Sidebars aren’t everyone’s piece of cake, but
then there’s no rule that says we all have to like
the same things. If you need a buddy while you
Web surf, a sidebar could be exactly the lifestyle
option for you.n
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Figure 2. What’s Related Sidebar
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Several Web browsers for Linux, besides being fast
and good looking, can save you quite some time
and annoyance while surfing the Web. If you
already have used the Internet for more than ten
minutes, you’ve also already suffered from what I
call browser fireworks. Theoretically, the World
Wide Web should help you find and use only the
information you need, as quickly as possible,
shouldn’t it? In practice, all too often you type a
URL, or click on a link, and July 4th happens: extra
windows that you never wanted to open pop up
everywhere, proposing unwanted on-line polls,
last-minute discounts, and what not. Other Web
sites are more “advanced”, offering the same
(dis)service all in one window—20% information,
80% assorted clip art and advertising banners.

Something else, less evident but potentially
more threatening for your privacy, may be happen-
ing in the background. You see, Web servers want
to keep a record of all the visits you make. They do
this by sending strings of text, called cookies, to
your browser. Every time you return to a Web site,
your browser transmits back the corresponding
cookie as an identification token. Now, sometimes
you do want this to happen: when shopping on-

line, for example, you want to buy more items at a
site after one visit, and you want to be recognized
as a person who deserves a discount after spend-
ing his or her whole paycheck there last week.
When, instead, Webmasters use cookies to profile
your on-line habits, violating your privacy, it’s an
entirely different matter, isn’t it?

DON’T SHOOT YOURSELF IN THE FOOT!
The right Linux browsers can help you save time
and protect you and your family’s privacy. It might
be in your interest, however, not to help yourself
too much. Turning off pop-ups, banners, and cook-
ies altogether could be a bad idea. First of all, some
on-line services that you do need might not work
anymore (banking, subscriptions to on-line fora,
and so on) if you disable everything. In the second
place, servers and bandwidth cost money. Often,
that money comes only from those very banners
and pop-ups we are going to block in a second.
Filtering too much might stop the only source of
income for some of the Web sites you like. If there
are more pop-ups and banners than useful infor-
mation, please consider writing a polite request to
the Webmaster to make the site lighter.

Enough preambles, let’s start blocking pop-ups
with Konqueror, the default browser and file man-
ager of the KDE desktop. The Web scripting lan-
guage used to manipulate browser windows is
JavaScript. Select Settings→Configure from the
main menu, click on the corresponding icon on
the left, and you’re in the Java and JavaScript
Konqueror panel, shown in Figure 1.

What’s going on there? Here, I’m telling
Konqueror what the Web pages of
http://www.tuxmagazine.com should be allowed
to do whenever I visit the site. Can you see, for
example, the several move, open, and resize
options? And, have you noticed the global key-
word? That’s the best part of it. You can define a
default (global) policy for unknown Web sites, and
then set up different stricter (or more relaxed)
rules for each Web domain. Basically, you can
decide who can yell at you and when—makes you
long for a similar panel in real life, doesn’t it? You
also can tell Konqueror to ask you every time
whether new windows can be opened.
Alternatively, the smart option is to allow the cre-
ation of new windows, but only as a consequence
of an explicit user action, like clicking on a button
or submitting a form. Unsolicited pop-ups always
are blocked in this case.

Stop the Browser Fireworks!
Some Web sites make you feel like you have lost
control of your browser because of pop-ups and
more. Marco Fioretti shows you how to use the
tools you have to get control back.

MARCO FIORETTI

Figure 1. Java and JavaScript Konqueror Panel
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Another popular browser, Firefox, goes even fur-
ther to keep your desktop clean. Look at Figure 2.
This is what you get the first time you point Firefox
to any site with pop-up windows. Note the yellow
stripe right below the tab titles; that’s not part of
the page, it’s a warning from the browser: “Firefox
prevented this site from opening two pop-up win-
dows.” Yes, that’s exactly what it is. By default,
Firefox never lets a Webmaster clutter your desk-
top, unless you explicitly say so. This is what the
drop-down menu on the right is for. Left-click any-
where on the yellow stripe to open it. From there,
you can open the pop-ups manually, allow the Web
domain to do it from now on, or fine-tune the
pop-up blocker behavior.

In fact, if we select the second option, we get
to the same window shown in the rightmost part
of Figure 3, the one titled Allowed Sites. To get
there without surfing, simply select the
Edit→Preferences entry from the main menu, and
then click on the Web Features icon. Unlike

Konqueror, Firefox has a dedicated check box only
for pop-ups, separated from the one dealing with
Java and JavaScript. In other words, pop-up block-
ing in Firefox is faster to reach, but it gives you
less options than the one in Konqueror—no smart
blocking or asking for confirmation here. Another
advantage of Firefox is that, being cross-platform,
you could share the same pop-up blocking config-
uration across all your computers. I say “could”
because to test it myself I should run other oper-
ating systems, but I don’t.

What about Mozilla, which is also cross-plat-
form? This heavyweight of the browser world is
the direct ancestor of Firefox. Practically speaking,
this means that we find the same options and
functionality of Firefox in Mozilla, as far as pop-ups
and JavaScript are concerned, only arranged in a
different way. Therefore, select Edit→Preferences,
and you should see something similar to Figure 4,
coming from Mozilla 1.7 for Linux. The pop-up
blocking options are the same as before, with a

more verbose explanation (which, if you paid
attention so far, you wouldn’t need anyway).

TESTING YOUR SETUP BEFORE GOING LIVE
There is an easy way to be sure that you have fig-
ured out exactly how to stop pop-ups without
risks. Play with the several configuration options
while visiting one of the test sites listed in the
Resource section. Some are offered as a service by
vendors of commercial pop-up blocking software.
They all contain pages made on purpose to test a
browser’s resistance under pop-up overload. Once
you can configure a browser to withstand all their
attacks, consider yourself graduated in Advanced
Browser Pop-up Prevention.

WHAT ABOUT COOKIES AND BANNERS?
Let’s go back to the Konqueror cookie manage-
ment interface, shown in Figure 5, and click the
two icons below the Java and JavaScript one we
used before. As with pop-ups, you can define, for
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Figure 3. Fine-Tuning Pop-up Behavior Figure 4. Pop-up Preferences in MozillaFigure 2. Pop-up Options in Firefox
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any Internet domain, different cookie poli-
cies. In this example we have said that we
want to accept all cookies from
http://www.knoppix.net, the home of the
finest Linux Live CD-ROMs around.

The Firefox configuration panel (Figure 6)
deals with cookies inside the Privacy section.
In this browser, you can specify exceptions
for different Web sites and view the exact
values and expiration dates of each single
cookie. Again, Mozilla has a similar interface,
so I won’t show that to you. One advantage
of Mozilla and Firefox over Konqueror (ver-
sion 3.2.0, the only one I had available while
writing this piece) is the capability to block

all images from a given server. Place the cur-
sor over an image and right-click. In Mozilla,
one of the choices is Block Images From This
Server. In place of the last two words, Firefox
shows the Internet domain from which the
image comes. Of course, before actually
blocking anything, remember what I told
you at the beginning. Within reasonable lim-
its, banners are essential for many free Web
sites to survive.

CONCLUSION
All the configuration parameters we have
discussed are stored in plain-text files. In
Konqueror, for example, have a look at

.kde/share/config/konquerorrc in your
Home Directory. You even can look at the
file using Konqueror. In the Location field,
type ~/.kde/share/config/konquerorrc and
press Enter. The file will show up in your
browser window. To give you an idea of
what it contains, here is what my version
of that file says about the TUX Web site:

[www.tuxmagazine.com]

javascript.EnableJavaScript=true

javascript.WindowFocusPolicy=0

javascript.WindowOpenPolicy=3

javascript.WindowResizePolicy=0

javascript.WindowStatusPolicy=0

The equivalent file for Firefox (alas, with
a different syntax) is called hostperm.1, and
it sits somewhere in your default Firefox
profile (look in the ~/.mozilla/firefox/ direc-
tory, again by using your browser). The
same applies to Mozilla, if you skip the
firefox part from the previous path.

And, now one last bit of advice.
Remember to include all the configuration
files of your browser(s) in your regular backup
plan (you do have one, don’t you?). It would
be really depressing, after a hardware crash
or other catastrophe, to lose your bookmarks
and see all the browser fireworks again.n
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Figure 5. Konqueror Cookie Management Figure 6. Managing Cookies in Firefox
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Firefox: http://www.mozilla.org/products/firefox
Konqueror: http://www.konqueror.org
Mozilla: http://www.mozilla.org/products/mozilla1.x

Pop-up Test Sites: http://www.popup-blocker.info,
http://www.kephyr.com/popupkillertest/test, 
http://www.popupcheck.com, and http://www.popuptest.com

RESOURCES
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The GNU Image Manipulation Program is the most
powerful interactive image processing application for
Linux. Its user interface is based loosely on the Adobe
Photoshop image editing package. Recent releases of
GIMP have taken it to levels both amateur user and
expert artist will appreciate.

The GIMP provides many of the same features as
Photoshop, from layers and vector paths to blend
modes and text manipulation. It also goes beyond
Photoshop by providing cross-platform versions
(Linux, Mac, and Windows) as well as support for
multiple scripting languages, which makes GIMP
perfect for Web-based animation production. And,
the wealth of image filters—from blurs to clouds to
impressionistic generators—that come standard with
the base GIMP distribution can handle editing tasks
both large and small.

GIMP supports very large images through the
use of a configurable tiling scheme that makes
optimum use of available memory. The native XCF
format allows you to save all your work in layered
format. Plugins are available that allow GIMP to
integrate easily with your digital camera, scanner,
and printer. Add Inkscape, a vector graphics pro-

gram, and Scribus, a Quark Xpress-like layout pro-
gram, to your editing pipeline to make any print
publication a thing of beauty.

Most recent Linux distributions now include
GIMP version 2.0. Though GIMP is not built using
the KDE environment, it works happily under it.

In this article, I introduce you to the what and
where of GIMP to provide a road map to the user
interface. In future articles and tutorials, I’ll dig
deeper into the how and why of GIMP to show
not only how various effects and tasks are per-
formed but also why they are needed.

THE ENVIRONMENT
The working environment for GIMP consists of
three main pieces: the Toolbox, image windows,
and the working dialogs. The Toolbox is the main
window and the only window in The GIMP that
remains open all the time. It contains a set of
icons for activating basic features such as selec-
tions, painting, and transforming images. It also
holds a menu at the top, the foreground and
background color selectors, the active brush, pat-
tern and gradients, and an optional window dock.

Image windows are where all the editing takes
place. Many image windows can be open at any
time. Each window is a composite view of an
image, based on which layers in that image cur-
rently are marked visible. Image windows have
many features. I cover these in more depth a little
later in this article.

Working dialogs are windows that let you
work with a variety of GIMP tools, many of which
are not directly accessible from the Toolbox icons.
This includes layers, channels, paths, the undo his-
tory, and the document history.

GIMP offers plenty of configurable preferences:
full-screen mode, conservative memory use for
resource-limited systems, tear-off menus, even

Touring The GIMP: The GNU 
Image Manipulation Program
Whether you’re working on the family album or an
art-house masterpiece, there is one tool no Linux
user should be without: The GIMP.
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Figure 1. The first time you start GIMP, it runs
through a number of setup windows. Once that
finishes, this layout is displayed: The GIMP
Toolbox and a vertical set of dock windows.

          

http://www.tuxmagazine.com


dynamic configuration of keyboard shortcuts.
Most of these options can be set using the
Preferences dialog (File→Preferences from the
Toolbox). Full-screen mode for any image window
can be toggled on or off by pressing F11 or by
using the View→Fullscreen menu option from the
Image Window menu bar.

THE TOOLBOX
The Toolbox is initially a vertical window of
icons attached to a single dock. The icons rep-
resent the basic set of artist tools. These
include tools for drawing and painting; creat-
ing and editing selections; performing various
transformations such as scaling, shearing, and
adding perspective; and choosing the active col-
ors, patterns and brush types. Clicking on an
icon in the toolbox activates the tool and, if the
Tool Options dialog is open or docked, displays
the Tool Options for that tool.

The Toolbox also has a menu bar with three

menus: File, Xtns, and Help. Xtns is primarily for
plugin developers, although you also can generate
predefined text logos using the Xtns→Script
Fu→Logos menu. The built-in Help system is thor-
ough, but be sure you have The GIMP Help files
installed for your language.

The layout for The GIMP Toolbox is config-
urable. Stretch the window vertically and hori-
zontally to suit your needs. Attach more docks
or detach them—the design intent was to make
GIMP’s environment as comfortable as you need
it to be.

A window dock allows you to group multiple
dialogs into a single window. Dialogs (see
File→Dialogs from the Toolbox main menu) are
available for many of GIMP’s features not
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Figure 2. Any dialog box can become a dock.
Simply drag dialog title bars onto a another dialog
title bar. This adds a tab with an icon to the dock.
Using docks, you can keep multiple dialogs open
and accessible with a click of a tab while freeing
up desktop real estate.

Figure 3. A slew of configurable options are avail-
able in the Preferences dialog. For slow machines
or ones with memory under 256MB, be sure to
look at the Environment options. For example,
setting fewer undo levels reduces memory 
consumption.

Figure 4. The GIMP toolbox consists of four main
areas: 1) the menu bar, 2) the tool icons, 3) the
foreground and background colors, and 4) the
active brush, pattern, and gradient indicators.
GIMP 2.2 adds an additional preview, showing the
currently active image window to make it easier
to identify at a glance which window will be modi-
fied by the next change you make.
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directly accessible through the Toolbox.
You can drag the dock handle (where the
dialog title is displayed) in any dialog and
drop it into any dock. The Tab menu (left-
pointing arrow icon) in a dock allows you
to detach dialogs.

The first time you start GIMP, you get

both the toolbox and an additional dock
window containing two docks. This win-
dow safely can be closed if you need 
the extra screen space. The tabs in the
docks can be dragged to the dock in the
toolbox if you prefer to keep them avail-
able at a mouse click. All the tabs are
dialogs that also can be accessed at any
time from the File→Dialogs menu in the
toolbox.

Leaving the mouse cursor over a tool for
a few seconds pops up a tip window, better
known as a tooltip, explaining that tool’s
basic purpose and use. Tooltips are active

on many features in GIMP. Experienced
users can disable tooltips from the
Preferences dialog.

THE IMAGE WINDOW
The toolbox, dialogs, and docks are
tools for doing work. The place you
actually do that work is an image
window. Image windows consist of 
a menu bar and a menu button,
scrollbars, rulers, a status area, and
the image display area. The image
display area shows a composite
image. Composite means all layers
and channels that currently are
marked visible are combined, in order
from bottom to top, to create the visi-
ble image. Changes made to any layer
or channel are displayed immediately
in the composite image.
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Figure 5. Tool options allow you to config-
ure tools. The options are kept between
uses, so using a tool and making a change,
then switching to another tool, does not
cause the first tool to reset to its default
settings.

Figure 6. The toolbox tooltips describe the
icons. Tooltips are offered up in various
other places in GIMP, though these can
become annoying after you’re familiar with
the program. Disable them in the
Preferences when the time is right.

Figure 7. The GIMP image window can
hide all of its features except the image
display area. It also can be displayed in
full-screen mode, which is useful for large
print projects.

NOTE:
In this article, I
often refer to the
image window as
a canvas window.
The term image
is somewhat
abused by The
GIMP community
and easily can
cause confusion
when not put 
in the proper
context. Canvas
window is fairly
unique and easily
references the
GIMP image 
window as a
whole, including
all associated
layers and chan-
nels. The on-line
documentation
for GIMP, however,
still refers to this
as the image
window.
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Because not all images you create will be wide
enough to show the entire menu bar, you might
not want to use it. It can be hidden from view
using the View→Show Menubar option in the
image window. Once it’s hidden you still can get
to the same menus by using the menu button or
by pressing and holding the right mouse button
while the mouse is in the image display area.
Having multiple ways of reaching the same menus
is another way The GIMP allows you more control
of your working environment.

Rulers are provided that show the width of
an image in pixels. The rulers play a double role
in that you drag guides from them. A guide is
straight line, horizontal or vertical, that can be
used for alignment of layers or as straight edges
for drawing and selection tools. Dragging a
guide back into a ruler removes it from the
image window.

The status bar lives at the bottom of the image
window. It can display a variety of useful informa-
tion in a configurable format (see the Preferences
dialog under the Interface→Image Window→Title
and Status section, and check out the on-line doc-
umentation for configuration options).

To the right of the status bar is the naviga-
tion control. The icon is a double arrow. When
the image is zoomed or larger than what the
image window can display, you can use the

scrollbars to navigate around the image.
Alternatively, the navigation control lets you
move around the image interactively. If you
work on large images, such as those destined
for print publications, the navigation tool tends
to be a much easier way to bounce around the
image than the scrollbars.

THE FILTERS
Most image editing programs provide basic
tools for drawing lines, changing colors, and
scaling images. What makes tools like The
GIMP exciting is the use of filters, also known
as plugins. Filters add features to GIMP either
by providing some functionality that doesn’t
exist in the core GIMP toolbox or dialogs—say
mapping an image to a 3-D shape, such as a
cube or cylinder—or that exists only as a series
of steps with existing tools.

Image scaling, rotating, and desaturating
(that is, removing all the color and leaving an
image black and white) can be applied to a
series of images in a directory. If the same
process needs to be applied to every image, it
would be a time-consuming project to do it all
one step at a time. Filters let you turn this
process into a single dialog with a point-and-
click interface.

GIMP comes with a large set of basic filters.
These are divided into menus of closely related
filters with titles such as blurs, artistic, distorts,
and render. Filters are either programs or scripts,
the latter coming in flavors of Perl, Python, and
Scheme. Filters written as scripts are similar to
Photoshop actions but far more versatile. If you
expect to do much work with animations (such
as those used on the Web) chances are good
that you’ll want to learn at least one of the
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NOTE:

All visible features of an image window (except
the image display area) can be hidden from
view. Check out the options under the View
menu in the image window menu bar.

Figure 8. The Filters menu is where you find edit-
ing tools that are less interactive in general, but
more sweeping in effect, than the toolbox tools.
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available languages.
Some of the most commonly used filters

include the Gaussian Blur (Filters→Blurs→Gaussian
Blur RLE) to simulate depth in photographs,
Noisify (Filters→Noise→Noisify) for aging photo-
graphs or as the seed for complex effects, and
Sharpen (Filters→Enhance→Sharpen) for use with
scanned photos.

When you’re in need of a specialized effect
or a good starting point for an image, try look-
ing at the Render filters. The Plasma filter
(Filters→Render→Plasma) is often used for cre-

ating clouds in a sky, and the Solid Noise
(Filters→Render→Solid Noise) filter is good for
simulating smoke.

Emboss (Filters→Distorts→Emboss) can turn a
2-D image into 3-D with little effort on your
part. Page Curl and Wind also often are used
and are easy-to-understand Distort filters.
Probably the most fun of the bunch is iWarp,
which can distort family photos into the true
aliens we see in our relatives.

RESOURCES
The primary source of information for The GIMP
is the Web site, http://gimp.org. Here you’ll find
an on-line manual (in multiple languages) as
well as tutorials and various helpful tips. A
developer site (http://developer.gimp.org) is
available for anyone needing information on
writing filters for GIMP. Various on-line tutorials
also are available from users with their own
Web sites, as well as a slew of GIMP mailing lists
for both end users and developers.

All the currently available books on the
GIMP are based on a pervious version. Expect
to see new books on the GIMP 2.x series later
this year.

The truly nice thing about The GIMP is that,
although it isn’t an exact feature clone of
Photoshop, the basic functionality is quite simi-
lar. This means many of the tutorials you can
find on-line for Photoshop and in texts easily
are mapped to features found in GIMP.

Then again, if you’d rather read tutorials
written specifically for The GIMP, stay tuned to
this column. I’m just getting started!n
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Figure 9. Noise is a good starting place for tex-
tures. Add a motion blur and you get the begin-
nings of a brushed metal effect. Figure 10. What could be more fun than going

from good to evil with only a few mouse clicks?
The iWarp filter lets you do exactly that.

Michael J. Hammel is an author, graphic artist, Web 
designer, and software developer currently working for
RLXTechnologies in Houston, Texas. He has spoken at the
ALS, LinuxWorld, and SXSW conferences, and chaired 
multiple conferences on Linux in Colorado. He is the 
primary maintainer for the MiniMyth build system, and 
he runs XEUS, his own development site for XNotesPlus,
Ximba Radio, and other open-source software. He can be
reached at mjhammel@graphics-muse.org, and his blog is
at http://www.ximba.org/wordpress.
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So you’ve finished dinner and the family is enjoying
a rare moment of downtime in the living room, and
then it happens: “Does anyone know the weather
for Saturday?” “What field is my soccer game on?”
“Is Dad’s flight coming in on time?” “What’s the
name of that Italian restaurant?” “Did Amy send
an e-mail about her party yet?” “Is that new movie
any good?” Suddenly, there’s a race for the home
computer. Somewhere—most likely in a different
room—a computer is being booted up. Downtime
is over; the living room is emptied.

What has happened here is that the answers we
need to day-to-day questions now are available
almost entirely from the family computer. Its power
as an information vehicle and communication medi-
um has woven itself into our lives. The problem,
though, is that using a computer is not an impulse
activity. Computers are “destination” devices. That
is, they occupy a specific location, and using one is
a “scheduled” activity. To get an answer to a ques-
tion or to fire off a quick message, one must place
oneself in front of it, boot it up, log in, and launch
an application. Afterward, one must shut it down or
log off, and often the machine requires updates and
maintenance. It doesn’t need to be this way, and in
the near future, it won’t be.

Indeed, the computer hasn’t strayed much from
its original position as a task station. Its design has
been driven largely by its use as an office tool
where new applications and evolving standards
drove concerns about flexibility and upgradeability.

The result: a general-pur-
pose design with modular
components (including
choice of operating sys-
tem—Linux, of course).

The power and productivity
afforded by e-mail, instant mes-
saging, and access to the sum
total of human knowledge on
the Web, however, was unavoid-
able, and computers wedged their
way into our homes. We found
ourselves forced to adapt our
schedules and even the layout of
our houses to accommodate this
design of computers into our lives.
Over the last decade or so this
was tolerable, because we shared
many of the concerns of business users.

Today, more computer users than ever
have no idea what is going on under the hood nor
do they want to know. They have been satisfied
with the performance of their home computer for
several years and feel no need to upgrade. More
importantly, some of these users have found that
the vast majority of their computing time is focused
on a small set of applications including e-mail, Web
surfing, and instant messaging. For these users, the
dust has settled, and the time has come for com-
puters to morph into devices that fit better into their
lives and better address their day-to-day needs.

WHAT WE NEED IS A LITTLE PEPPER
Enter the new Pepper Pad 2 from Pepper
Computing, Inc. (http://www.pepper.com). I had the
opportunity to test-drive a Pepper Pad recently and
found it to be possibly the best thought-out periph-
eral home computing device I’ve ever seen. The peo-
ple at Pepper Computing were kind enough to invite
me in to take a look this rather cool, Linux-based
personal computing platform. You should know up
front that the unit I looked at was a pre-release
model with production units expected to appear in
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The Pepper Pad 2: First Impressions
What’s bigger and more capable than a PDA but smaller than a desktop computer? Meet the Pepper Pad 2.
DAVID HITRYS

Figure 1. The Pepper Pad 2
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stores sometime before this magazine appears.
Consequently, this is more a reflection of my first
impressions rather than an out-and-out review.

Focused on the everyday needs of the residential
computer user, the Pepper Pad 2 is designed from
the ground up to provide an instant-on, trouble-free,
easy-to-use wireless computing device that’s always
within reach. About the size of a thick magazine, the
device looks much like a small flat-panel television,
complete with built-in stereo speakers. The presence
of a small QWERTY keypad (cleverly divided in half
by the 8.4" LCD screen), stylus pen, scroll wheel, and
the gently curved, rubberized frame, though, por-
tend that this is an interactive device that’s meant to
be picked up, held, and used. Once lifted, the two-
pound device fits neatly into the hands, with thumbs
falling naturally onto the keypads. On the brightly lit
touch-sensitive screen are colorful icons that show
the most commonly used applications. Touching the
Web icon instantly opens a Mozilla browser. E-mail
and Instant Messenger (AOL-compatible) are also

available, as are a number of other applications,
such as a word processor, MP3 player, streaming
Internet radio, a photograph organizer, scrapbook,
games, and even a video player. More applications
(Pepper Packages) are available for download at the
company’s Web site.

Opening a number of applications at the same
time reveals another strength of the design of the
Pepper Pad—the screen never gets cluttered. All open
applications are represented by a small tab at the top
of the screen and are available by a single click (or
touch of the stylus). The drag-and-drop metaphor is
used extensively throughout, making it easy to organ-
ize address books, music libraries, photographs,
videos, and to create custom scrapbooks that can be
shared easily with friends. Further fulfilling its role as
the gotta-have device for the family room, the unit
even includes software and an infrared port allowing
it to function as a master remote control for your TV,
CD player, and other equipment. The built-in speak-
ers produce crisp, clear sound, effectively making the

unit double as a high-quality, Internet-connected
table radio. For a close-up look at all the bells and
whistles on this unit, have a look at Figure 2.

People with experience using small keyboards on
PDAs or Blackberry devices will find typing an e-mail
message, Web address, or other text into the Pepper
Pad to be easy and straightforward. For others, a few
minutes of practice may be required. The keys pro-
vide a crisp feel and are backlit for easy viewing. Even
after 45 minutes of Web browsing and e-mailing, the
Pepper Pad continued to feel comfortable to use.

Battery life is estimated at several hours, and the
battery (lithium polymer) recharges rapidly. It also can
be plugged in to AC power and run indefinitely. The
unit I looked at included Wi-Fi (802.11b), IR, a 20GB
hard disk, an 8.4" color LCD screen, QWERTY key-
pad, Bluetooth, USB 2.0, and a memory card slot
that accommodates SD/MMC. To ensure reliability
and eliminate maintenance issues, neither the oper-
ating system (Linux) nor the files for core applications
(written in Java) are accessible directly by users.

The Pepper Pad 2 should be available in January
of 2005 (certainly by the time you read this sneak-
peek preview), and the company is accepting orders
at its Web site. The price is expected to be about
$800 US and includes a three-month warranty.

It is clear that at some point in the very near
future, people will not be required to disrupt their
daily life simply to access basic computing needs.
Instead, dedicated, easy-to-use and maintenance-
free wireless computers will be found sitting on
end-tables and nightstands in most homes and
apartments. Will it be the Pepper Pad? With its
clean design and laser focus on the core applica-
tions that most people use everyday, it appears
that the Pepper Pad is going to be huge hit.n

David Hitrys can be reached at dhitrys@rcn.com.

Figure 2. 
The Pepper Pad
2’s specifications
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TUNGSTEN T5

palmOne: http://www.palmone.com
Estimated price: $399 US / $599 Canada

Palm handhelds have long been trusted compan-
ions for those who need to stay organized. The Palm
operating system has come a long way since the very
first Palm Pilot, but the handhelds continue to offer
the same ease of use and stability that made that
first early entry into the PDA space so valued.

The Tungsten series is the executive line of
handhelds currently available from palmOne, and
the new Tungsten T5 is the newest and brightest.
This time around, there even have been a few
core changes to how the device works.

First of all, the Tungsten T5 comes with a
whopping 256MB of memory onboard, four
times the amount found on the T3 model. Even
better, that’s Flash memory, which means that
when you finally run out of battery power, which
almost every Palm user has done at some point,
you won’t lose all of your data.

It also means you can use the T5 as a removable
USB drive with any computer that supports external
USB drives natively; 160MB of the T5’s total memory

is set aside as an internal
Flash drive. To turn the
handheld into a remov-
able drive, there’s a
new icon on the Palm
called Drive Mode. Once
you’re in Drive Mode, you
can drag and drop files and
applications onto the Tungsten
or remove them in the same way.
That’s right—applications, too—no
more of that pesky HotSync’ing to get
new apps onboard.

Four categories already are set up under
the Files menu, including Applications,
Documents, Music, and Photos & Videos.
Simply drag your files into the appropriate folder,
and they’ll show up in the appropriate place. Music
files are accessible from the Real Player, photos and
videos from the Media application, and applications
from the regular applications menu, though you
need to select INTERNAL from the drop-down cate-
gory menu. (You also can get to your files with the
touch of the Files launch button, on the far right of
the five-way navigation button below the screen.)

This is a nice feature for Linux users for a key
reason: if your version of the operating system
automatically recognizes external USB drives, you
don’t have to install specialty apps on your box
just to get files onto the Tungsten T5.

If you want to synchronize your calendar and
address book, you still have to find and install the
proper applications. (Personally, I don’t bother
with a computer at all when it comes to manag-
ing my calendar and contacts; I prefer to enter
everything directly into the Palm and back up my
data to a SecureDigital card.)

At 1.5cm thick, the Tungsten T5 isn’t the
thinnest handheld out there, but thinner mod-

els aren’t thinner by all that much. Despite
the svelte design, they’ve still managed to

squeeze a lot under the hood. That
includes the same 3205480 screen

found on the T3, with an onscreen
Graffiti pad that pops up only
when needed (or requested); the
screen can flipped from portrait
to landscape mode with a tap of

the stylus.
The T5 has built-in Bluetooth,

allowing you to connect to the
Internet if you have a Bluetooth-enabled

phone (and a suitably robust data plan).
There’s even a SecureDigital slot, for extra storage
or SDIO-compliant peripherals.

As with previous models in the Tungsten line,
one of the main complaints about this one is the
internal battery. Sure, if you’re not using Bluetooth
all the time, it’ll last you quite a while, but as with
all batteries, eventually it’ll poop out. Worse, once
it’s finally gone to battery heaven, you’ll have to
send the unit in for a costly service call, instead of
being able to replace the battery yourself.

Something that may be surprising is the move
from the synchronization cradle to a fairly stan-
dard USB cable, especially with the higher-end
models. The good news is you won’t have to find
a place to put the sync cradle; the bad news is
you’ll have to plug in the T5 manually every time.

If you’re in the market for a stylish and pow-
erful new handheld, these may be small con-
cerns. The T5’s new drag-and-drop method of
file transfer is a great new feature, especially for
those running Linux.

The Gadget Guy
Who says you can’t take it with you? Contacts,
appointments, music, and all your data are totally
portable. Plug ’em in, load ’em up, and head ’em out!
Sean Carruthers reviews four great gadgets that may
soon be finding a home on your computer’s USB port.
SEAN CARRUTHERS

            

http://www.palmone.com
http://www.tuxmagazine.com


GIGA-COOL: ONE GIGABYTE USB FLASH DRIVES

What’s over 700 times the capacity of a
floppy disk and also about one-tenth
the size? A 1GB USB 2.0 Flash drive, of
course. Removable USB Flash drives have
been on the market for a few years now,
but recently they’ve shot up in capacity
even as the price has dropped sharply.

I recently had the chance to look at 
two new 1GB drives, one from Imation
(http://www.imation.com) and the other from Iomega
(http://www.iomega.com). Both drives are quite slim,
and both feature attached swiveling caps that protect
the USB connector when the drive isn’t in use. More
importantly, both are recognized automatically as
removable drives by newer distributions of Linux.

Imation’s USB 2.0 Swivel FlashDrive is about
the size of a typical house key, with a protective
cap that swivels to the side when the drive is in
use and clicks down over the USB connector
between uses. It comes with a lanyard and a USB
extension cable. There’s a write-protect tab at the
end of the drive to make sure you don’t acciden-
tally erase important files. The drive is also avail-
able in 128MB, 256MB, and 512MB capacities,
and Imation recently also has announced a 2GB
version—impressive. The downside—at the time

of this writing the 1GB drive is a
hefty $289 US. Because the 2GB

version is expected to debut at
$300 US, it’s probable that
the prices of the lower-
capacity models will drop.

Physically, Iomega’s Micro
Mini is even smaller, with a
body that’s barely larger
than the USB connector

itself. In fact, the protective cap can spin
all the way around the drive. Each Micro
Mini drive comes with three caps (orange,

blue, and charcoal), a lanyard, and a
USB extension cable. There aren’t
any bonus features here, 1GB of
storage in an ultra-compact
design. The price is right, though,
at $180 US. The Micro Mini is
also available in 64MB, 128MB,

256MB, and 512MB capacities.

GOING MICRO WITH THE MUVO—MUVO MICRO N200
Creative: http://www.nomadworld.com

For those looking for a compact Flash memory-
based MP3 player, Creative’s MuVo line has long
been attractive. The original MuVo was a small
two-piece player that consisted of a battery mod-
ule and a USB Flash drive that also had player con-
trols. Stick the Flash drive into your computer’s USB
port and you could drag your digital audio files
straight onto the player, as well as any other files
that could fit (JPGs, documents, whatever). Slide
the Flash drive into the battery pack and you had
an MP3 player that ran on a single AAA battery.

The newest member of the MuVo line is the
Micro N200, and it has shunned that two-piece
design in favor of an even more compact form fac-
tor. Now, instead of a separate battery pack, the
AAA battery goes right inside the drive, and instead
of placing the USB connector on the end of the Flash
drive, it requires a separate cable. This change is cer-
tain to disappoint people who loved the ability sim-
ply to remove the MuVo from the battery sleeve and
plug it straight in to a USB port, sure. On the other
hand, the smaller design will be a real plus for those

who need
to travel
light,
whether
it’s for exer-
cising or for
smuggling into boring
meetings. Because the player still
is treated as a removable drive, you can
load up your MP3s and move your files from
computer to computer, whether you’re using new
versions of Linux, Mac, or Windows.

The player handles MP3 and WMA files, has an
FM radio and a voice recorder built in, and even
records the radio. It comes with a flexible clip-on
case and a sports armband, but it’s small enough
that most users can tuck it into a shirt pocket.
One really nice improvement with the Micro N200
is the headphones. They actually sound good this
time around, so unless you’re particular, you prob-
ably won’t feel the need to buy a replacement set.

The MuVo Micro comes in eight fun colors,
including white, pink, orange, red, lime green,
light blue, dark blue, and basic black. It also
comes in four different capacities to meet your
budget: 128MB ($99 US), 256MB ($119 US),
512MB ($129 US), and 1GB ($199 US).n
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Sean Carruthers is a freelance technology
journalist from Toronto. He spent six
years at Canada Computer Paper, first as
Products Editor at The Computer and
later at HUB Digital Living magazine. As a
freelancer, he has written for the Globe
and Mail, http://globetechnology.com,
HUB Digital Living, Computer Dealer

News, Homefront and CE-Biz. While a relative newbie with Linux
(SuSE, thank you very much), he has extensive experience with
tech gadgets of all sorts and is enjoying figuring out which ones
are compatible with Linux.
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eBay is a popular auction portal that lets
visitors search for used or new products at
a reduced price and bid on those items. It
also can be extremely addictive and time
consuming. Because of the tremendous
popularity of eBay, the site features, at any
point in time, several millions of items, and
it is quite tempting to bid away on several
items and lose tracks of your bids.

Bidwatcher is a friendly little program
that just might save you both time and
money. It allows you to track eBay auctions,
whether or not you are bidding on them.
All you need to start using Bidwatcher is to
grab the item number for the item you

want to track, enter it in Bidwatcher’s input
field, and the item is added to the list of
items you are watching.

Additionally, Bidwatcher allows you to
place a bid on an item directly from the
program, synchronize the list of items you
are watching with your eBay account, as
well as to create snipes.

What in the world is a snipe, you
ask? Sniping is an efficient way to tell
Bidwatcher to place a bid on a particular

item a few seconds before the auction
expires. This functionality potentially can
save you a lot of money, especially if you
are competing with a large number of
bidders on an item.

The user interface is easy to use. The
toolbar on the top part of the window
allows you to access the preferences menu
(this is where you need to provide your
eBay account info), synchronize the pro-
gram with eBay’s official time, update all

your bids, and add a new bid to your list.
All operations on individual bids are

performed by holding the right button of
your mouse on an item, which opens up
a new context menu for that item. This
menu allows you to place a bid, create
or cancel a snipe, display information
about an item, or simply open a browser
window on the eBay listing for that item.n

— X a v i e r  S p r i e t

An interesting member of the KOffice
family of products is Kivio. Kivio is a
flow-charting application that allows you
to create all kinds of diagrams and flow
charts. The purpose of this kind of dia-
gram is to express an idea or a process in
a logical and professional layout.

Kivio ships with a fair amount of
stencils, which you can use while creat-
ing your diagrams, but it also has the
ability to import stencil sets from Dia,
another popular diagramming applica-
tion. Additionally, you can find more
stencils on the Net or purchase specific

stencils sets from theKompany.
Creating diagrams with Kivio is 

trivial. Objects, by default, snap to the
grid in a non-intrusive way, allowing
you to lay out elements professionally,
and the text style for the content inside
any object can be modified in any way,
which gives you even more control over

the visual aspect of your flow charts
and diagrams.

The Kivio Handbook provides an
extensive amount of documentation on
how to work with the application, and

the configuration dialog allows you to
change a few aspects of Kivio’s behavior.

You cannot export a Kivio diagram as
a Dia diagram because only the Kivio-
specific formats are supported for import
and export. One alternative is to take a
screenshot realizing that the result will
be a bitmap rather than the line drawing
format that Kivio offers.

Kivio is tightly integrated into the
KOffice suite, which makes it easy to use
Kivio objects and diagrams inside any
KOffice document. You simply create a
new Kivio frame within a KWord docu-
ment and create your flow chart directly
inside your document.n

— X a v i e r  S p r i e t

Bidwatcher Tracking Several eBay Auctions

Kivio’s Stencil Categories

Basic Flow Chart in Kivio

Bidwatcher

Kivio

About Bidwatcher:

• License: GNU General Public
License (GPL)

• Price: Free
• Home Page:

http://bidwatcher.sf.net
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Many times you don’t need the
advanced features of a word
processor such as found in the
OpenOffice.org suite. That is,
something less complicated with
the side benefit of starting very fast
better fits your needs. KWord is an
example of a well designed and
quite intelligent word processing
program that is reliable, user-
friendly, and surprisingly fast.

The most obvious issue any
KWord user will encounter is the fact
that its MS-Word filter does not sup-
port export. This means you cannot
save a document in MS-Word for-
mat. Fortunately, KWord makes up
for this problem in several key areas.

KWord Is Fast
Although it cannot export to MS-
Word format, KWord has no prob-
lem opening a Word document, and
it does so very fast. So fast, that I
actually have set up my e-mail client
to open all word files with KWord by
default. Documents are opened and
rendered on your screen in the blink
of an eye.

KWord Is Intelligent
KWord features an impressive
Auto-correction module that
allows you to specify how you

want KWord to
behave. This has the
benefit of being non-
intrusive, because
you tell the applica-
tion what it should
correct for you, yet
practical, as most
common typing
errors can be correct-
ed automatically. For
example, KWord can
convert any word
that has the two first
letters in uppercase,
to having only the
first letter in upper-
case (for example,
THis replaced by
This). It also capital-
izes names of days
(and because KWord
is fully international-
ized, it recognizes
names of days in
your language too),
suppresses double-
spaces, and has a list of the most
common typos and useful correc-
tions for your language.

KWord Is Intuitive
The main user-interface window of
KWord is simple to use. The toolbar
is not overly filled with advanced
alignments and object manipulation
buttons, and the formatting bar

focuses on the most common for-
matting operations (font changes,
borders, standard alignment, colors,
and so on). This makes creating new
documents a breeze, and because I
mostly export my documents to PDF
instead of MS-Word, I have no prob-
lem authoring and distributing docu-
ments created with KWord.n

— X a v i e r  S p r i e t
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KWord

KWord’s Simple Auto-Correction Settings KWord’s Advanced Auto-Correction Settings

KWord’s Main Window

About KWord:

• License: GNU General Public
License (GPL)

• Price: Free
• Home Page:

http://www.koffice.org/kword
• KWord is distributed as part of

the KOffice suite of products.
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TUX is the first and only magazine for
the new Linux user. In each digital edi-
tion of TUX, we explore every facet of
the modern Linux desktop, providing a
new breed of Linux user with the tools
and information to make their Linux
desktop experience complete.

A new breed of Linux user has emerged,
the Linux consumer. TUX delivers to this
powerful and rapidly growing economic
force by offerring many advertising
opportunities for both its digital edition
and its web site.

ADVERTISING

Contact the TUX team
today to have a media kit
sent to you. E-mail
ads@tuxmagazine.com or
call 206-782-7733 ext.4

www.tuxmagazine.com

UPCOMING ISSUES INCLUDE:

May 2005
The HOME ENTERTAINMENT Issue
Welcome to your Linux home
entertainment center. Use your
PC to watch TV, record programs,
and more. This month, TUX looks
at MythTV, Freevo, and other per-
sonal video recorders (PVRs). We'll
also take a few Jukebox servers
out for a spin so you can play
music anywhere in your house
from the comfort of your PC. And
did we mention radio? Movies,
music, and more, in the May
2005 issue of TUX.

June 2005
The LIVING WITH WINDOWS Issue
Is yours a house (or office) divided?
With Linux PCs here and
Windows PCs there? In the June
2005 issue, TUX shows you all
you need to know to share files
and folders between these differ-
ent systems. We'll also look at
tools that make running Windows
on Linux (and vice versa) easy.

July 2005
The MONEY Issue
If money makes the world go
'round, this is a well rounded
issue of TUX as we explore finan-
cial applications in the Linux
world. We'll cover home finance
programs that provide simple
cheque book functions as well as
those that do it all. Join us as we
explore expense trackers, stock
tickers, and business-ready
accounting software. Ka-Ching!

August 2005
The EDUCATION Issue
TUX goes back to school in the
August 2005 issue. Linux systems
are a great solution for cash
strapped schools, but they offer
much more than inexpensive,
stable, and secure systems. Kids
will find software to challenge
their minds and have fun doing
it. From Linux at school, to 
educational programs, to 
educational games, it's Linux 
for kids of all ages.

September 2005
The SWITCH Issue
Finally, it's time to help those in
need. Yes, we're talking about
people running something other
than Linux—those poor unfortu-
nate souls who deal with adware,
spyware, and system crashes
every day of their lives. TUX will
look at great Linux business tools,
live Linux CDs (to introduce your
friends and family), and transi-
tional applications (Linux pro-
grams that are available for
Windows) so that even if they
continue to run something else,
they can at least get some of the
benefits of Linux.

October 2005
The LINUX AUTOMATION Issue
Whatever happened to computers
making our lives easier and giving
us more free time? Maybe it's
because they weren't running
Linux. This October 2005, TUX
will show you how to put your
Linux system to work while you
sleep! Let Linux take care of

business and watch over things
while you tend to other, more
important things. In this issue,
TUX will look at home security,
webcams and video surveillance,
maybe even a robot or two.

November 2005
The PERSONAL COMMUNICATIONS
Issue
As the end of 2005 approaches,
talk is hot again and Linux makes
it easy. The year 2000 has come
and gone, but picture phones are
finally here, instant messaging is
everywhere, free long distance is
a reality, and everybody is reach-
ing out and touching somebody
somewhere. Get into the instant
messaging, Voice Over IP, text
messaging, and just plain talking
action in the November 2005
issue of TUX.

TUX magazine
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